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Dorico 2.1 
 

2018 年 8 月 10 日 

このバージョンの新機能、改善点および解決済みの問題を以下に記載します。 

 

新機能 
 

スウィング再生 

Dorico 2 はスウィング再生機能をサポートしました。プロジェクト全体に対するデフォ

ルトのスウィングパターンの設定や、楽譜の任意の位置でのスウィングの深さの変更

を行なえます (ストレートとスウィングの切り替えも行なえます)。また、異なるプレーヤ

ーが同時にそれぞれ異なるスウィングパターンを演奏できます。 

Anders Friberg および Andreas Sundström の著作による、スウィングがミュージ

シャンにより実際にどのように演奏されるかに関する学術調査に基づき、Dorico の

スウィングパターンはテンポにより変動します。遅いテンポではスウィングをより強調

し、速いテンポになるほどストレートに近くなります。すべてのテンポで同じ比率による

演奏を行なうスウィングのフィールも用意され、オリジナルのスウィングパターンを定

義できます。 

プロジェクト全体のスウィング設定: スウィングをプロジェクト全体で有効にするには、

「再生 (Play)」 ▸「再生オプション (Playback Options)」を開いて「タイミング 

(Timing)」ページを選択します。「デフォルトのリズミックフィール (Default rhythmic 

feel )」メニューから任意のスウィングパターンを選択します。 

 2:1 スウィング (一定) (2:1 swing (fixed)) – 3 連スウィングとも呼ばれ、8 分

音符のペアの 1 つめの音符を 2 つめの音符の倍の長さに引き延ばし、厳密な 

2:1 の比率の 3 連符を表現します。この比率はテンポに左右されず維持されま

す。 

 3:1 スウィング (一定) (3:1 swing (fixed)) – 8 分音符のペアの 1 つめの音符

を 2 つめの音符の 3 倍の長さに引き延ばし、付点 8 分音符と 16 分音符の

比率を表現します。この比率はテンポに左右されず維持されます。 

 重いスウィング (Heavy swing) – テンポに従いスウィングの比率が、遅いテンポ

で 3.5:1 から、速いテンポで 1.5:1 までの範囲で変動します。 

 軽いスウィング (Light swing) – テンポに従いスウィングの比率が、遅いテンポ

で 1.5:1 から、速いテンポで 1:1 (ストレート) までの範囲で変動します。 

 ミディアムスウィング (Medium swing) – テンポに従いスウィングの比率が、遅

いテンポで 2.5:1 から、速いテンポで 1:1 (ストレート) までの範囲で変動します。 

 ストレート (スウィング無し) (Straight (no swing)) – すべてのテンポで比率 1:1 

のイーブンな 8 分音符を表現します。  
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フローの途中でスウィングを変更する: プロジェクトの特定の部分でスウィングパター

ンを変更するには、スウィングパターンを変更する位置の音符、休符またはその他の

アイテムを選択してから、[Shift]+[T] を押してテンポのポップオーバーを開きます。

使用するスウィングパターンの名前の最初の文字を入力します。たとえば「med」と入

力すると、ミディアムスウィングが提案リストに表示されます。下矢印キーを使用して

選択し、[Return] を押して確定します。組段の最上段の譜表にガイドが表示され、リ

ズミックフィールの名前を表示されます。 

アンサンブル中の 1 プレーヤーだけ使用するスウィングパターンを変更するには、

まず対象となる譜表の音符、休符またはその他のアイテムを選択するか、キャレット

を配置し、[Shift]+[T] のポップオーバーを開いて下矢印キーでスウィングパターンを

選択します。最後に、[Alt]+[Return] を押してポップオーバーを確定させると、選択

した譜表にガイドが表示され、リズミックフィールの名前を表示されます。 

リズミックフィールの変更は小節の開始位置からしか効果を発揮しないため、小節の

途中でリズミックフィールを変更した場合、その効果が現れるのは次の小節の開始位

置からになります。 

スウィングパターンの変更を削除するには、単に該当するガイドを選択して [Delete] 

を押します。リズミックフィールのガイドを表示または非表示するには、「ビュー 

(View)」 ▸ 「ガイド (Signposts)」 ▸ 「リズミックフィール (Rhythmic Feel)」で選択

できます。 

スウィングパターンを編集する: デフォルトのスウィングパターンを編集する、または

オリジナルのスウィングパターンを設定するには、「再生 (Play)」 ▸ 「再生オプション 

(Playback Options)」で「タイミング (Timing)」ページを開き、「リズミックフィール 

(Rhythmic Feel)」セクションの「編集 (Edit)」ボタンをクリックして「リズミックフィール

を編集 (Edit Rhythmic Feel)」ダイアログを開きます。 
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プロジェクトに設定されているリズミックフィールは左側のリストに表示されます。デフ

ォルトのリズミックフィールを新規に作成するには、「新規 (New)」をクリックします。

現在選択しているリズミックフィールのコピーを作成するには、「選択部分から新規作

成 (New from Selection)」をクリックします。現在選択されているリズミックフィール

をユーザーライブラリーに保存して、これ以降に作成するすべての新規プロジェクトで

利用できるようにするには、「デフォルトとして保存 (Save as Default)」をクリックしま

す。 

ダイアログの右側には、スウィングパターンを定義するための簡単なコントロールが

いくつかあります。 

 「テンポに依存 (Depends on tempo)」は、スウィングパターンがすべてのテンポ

で常に同じ比率を使用するかどうかを決定します。オフのときは、「遅いテンポ 

(Low tempo)」と「速いテンポ (High tempo)」のコントロールが無効となり、スウ

ィングの比率のスライダーが 1 本だけ表示されます。 

 「遅いテンポ (Low tempo)」に (1 分間に演奏される 4 分音符の数で) テンポ

を指定すると、それ以下のテンポでは右側のスライダーで指定するスウィングの比

率が使用されます。 

 「速いテンポ (High tempo)」にテンポを指定すると、それ以上のテンポでは右側

のスライダーで指定するスウィングの比率が使用されます。 

 スウィングの比率のスライダーは、1:1 (ストレート) から 5:1 (1 つめの 8 分音符

が 6 連符の 5 つ分の長さを占め、2 つめの 8 分音符が残り 1 つ分の長さと

なる) までの範囲で設定でき、比率と、スウィングのパーセントによる割合の両方

を表示します。 

「テンポに依存 (Depends on tempo)」がオンのときは、「遅いテンポ (Low 

tempo)」に指定されるテンポ以下においてはそこに指定されるスウィングの比率が使

用されます。そこからテンポが増加すると、「速いテンポ (High tempo)」に指定され

るテンポに達するまで、そこに指定されるスウィングの比率に向かって Dorico がス

ウィング値の補間を行ないます。「テンポに依存 (Depends on tempo)」がオフのと

きは、1 本のスライダーで指定されるスウィングの比率がすべてのテンポで使用され

ます。 

 

符頭設定エディター 

「浄書 (Engrave)」 ▸ 「符頭設定 (Notehead Sets)」ダイアログが新たに追加され、

内蔵の符頭設定に変更を加えてオリジナルの設定を作成できるようになりました。 

符頭設定は、関連しあう符頭を 1 つにまとめたものです。同じ符頭は複数の符頭設

定で使用できるため、1 つの符頭設定で符頭を編集した場合、その符頭を使用する

すべての符頭設定に対し変更が適用されることに注意してください。 
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標準の符頭設定には通常少なくとも 4 つの符頭が設定されています。4 分音符以

下のデュレーションの音符に使用する黒玉の符頭、2 分音符に使用する白玉の符頭、

全音符に使用する幅広い白玉の音符、倍全音符に使用する、両側に 1 本か 2 本

の短い縦線が付いた幅広い白玉の符頭、または四角い白抜きの符頭があります。

Dorico がサポートする符頭設定はこれ以外に 2 種あります。音符の音程に従って

選択した音符が変化する「ピッチ」と、現在の調号に対する音符の音度に従って選択

した音符が変化する「音度」です。ピッチの符頭設定で最も一般的なものは、「ピッチ

名符頭 (Pitch name noteheads)」の符頭設定で、これは各音符のノート名をアル

ファベットで (臨時記号が付く場合はそれも含めて) 音符の形状の中に表示するもの

です。音度の符頭設定には、セークリッドハープ歌唱やシェイプノート歌唱に使用され

る「Aikin 7 種の形状 (Aikin 7-shape)」などがあります。 

特定の種類の符頭設定 (標準、ピッチ、または音度) には、同じ種類の符頭しか使

用できません。たとえば、ピッチの符頭設定の中に標準の符頭は使用できないため、

既存の符頭設定または既存の符頭の種類は単体では変更できません。 

「浄書 (Engrave)」 ▸ 「符頭設定 (Notehead Sets)」ダイアログは 3 つのエリアに

分けられています。 

 

 

 

 

 

 

 

 

 

 

左側では、設定を行なうカテゴリーを選択します。ここのカテゴリーは「編集 (Edit)」▸ 

「符頭 (Notehead)」サブメニューの内容に対応します。それぞれのサブメニューにど

の符頭設定を表示するかを変更するには、左側のリストから符頭設定を選択してから、

右上の「符頭設定 (Notehead Set)」セクションにある「カテゴリー (Category)」ドロ

ップダウンリストでカテゴリーを変更します。 

左側のリストの下には、符頭設定の作成ボタンと削除ボタンがあります。 

 「新規 (New)」は、「一般 (Common)」カテゴリーに標準タイプの空白の符頭設定

を作成します。 
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 「選択部分から新規作成 (New from Selection)」は、現在選択している符頭設

定と同じタイプで同じカテゴリーに属するコピーを作成します。新しい設定に含まれ

る符頭は、そのもととなった設定と同じであることにご注意ください。新規設定に含

まれる符頭だけに変更を加える場合は、既存の設定に含まれる符頭をもとにして

新たに符頭を作成するようにしてください。 

 「デフォルトとして保存 (Save as Default)」は、選択した符頭設定をユーザーライ

ブラリーに保存し、これ以降に作成するすべての新規プロジェクトで使用できるよう

にします。 

 「出荷時の設定に戻す (Revert to Factory)」は、内蔵の符頭設定に対してのみ

有効となります。内蔵の符頭設定に何らかの変更を加えていた場合、これによりデ

フォルトの状態が復元されます。 

 「削除 (Delete)」は、現在プロジェクト中の音符に使用されていない場合に限り、

カスタムの符頭設定を削除できます。内蔵の符頭設定は削除できません。 

右上の「符頭設定 (Notehead Set)」セクションには、現在のセットに設定されている

符頭が表示されます。 をクリックして、現在のセットに既存の符頭を追加します。現

在のセットと同じタイプのすべての符頭のリストがメニューに表示されます。現在のセ

ットから符頭を削除するには、 をクリックします。これはその符頭がプロジェクト内

で使用されていない場合のみ有効になります。この符頭設定が表示されるカテゴリー

を指定するには、「カテゴリー (Category)」リストから任意の項目を選択します。「デ

フォルトの符頭 (Default notehead)」は、音符の要求に合致する符頭がセット内に

存在しない場合、どの符頭を使用するかを指定します (たとえば、全音符より長い音

符に対し適切なデュレーションの符頭がセット内に定義されていない場合、デフォルト

の符頭がかわりに使用されます)。 

符頭設定の「タイプ (Type)」は変更できません。ピッチまたは音度による符頭設定を

作成する場合、既存の符頭設定から任意のタイプのものを選択してから「選択部分か

ら新規作成 (New from Selection)」を使用して、選択に基づく新規符頭設定を作成

します。 

右下の「符頭 (Notehead)」セクションは、右上の「符頭設定 (Notehead Set)」セク

ションのグリッドコントロールで選択中の符頭のプロパティを表示します。それぞれの

符頭に対し、以下のプロパティを編集できます。 

 名前 (Name): 上部のグリッドコントロールのアクションバーのメニューに表示され

る符頭の名前です。 

 デュレーション (Duration): その符頭を使用するデュレーションです。符頭の外観

の大部分において、4 分音符とそれ以下のデュレーションの音符には同じ符頭が

使用されます。この場合この符頭には、「1/4 音符 (1/4 note)」を選択してから、

下の「これ以下のデュレーションに使用 (Use for durations shorter than and 

equal)」を設定します。 
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 「これ以下のデュレーションに使用 (Use for durations shorter than and 

equal)」をオンにすると、上の「デュレーション (Duration)」で指定したデュレーシ

ョンだけではなく、それより短い音符に対してもこの符頭が使用されます。 

 「これ以上のデュレーションに使用 (Use for durations longer than and 

equal)」をオンにすると、上の「デュレーション (Duration)」で指定したデュレーショ

ンだけではなく、それより長い音符に対してもこの符頭が使用されます。 

 「符尾の方向 (Stem direction)」では、符尾が上向きの音符または下向きの音符

に対してのみこの符頭が使用されるよう指定できます。(たとえばシェイプノートの

体系の場合、符尾が上向きまたは下向きの音符において、符頭の三角形は符尾

とは逆の方向に向きます。) 

 「倍全音符 (Double whole note)」では、この符頭が名目上「丸 (Round)」また

は「四角 (Square)」のどちらであるかを指定できます。これにより、「浄書オプショ

ン (Engraving Options)」の「音符 (Notes)」ページの「倍全音符 (ブレーベ) の

符頭の外観 (Appearance of double whole note (breve) notehead)」に、「丸 

(Round)」または「四角 (Square)」のどちらが設定されているかに応じて表示され

る符頭が決定されます。 

 「ピッチ (Pitch)」 (「ピッチ」タイプの符頭のみ) は、この符頭を使用する音符のノ

ート名と臨時記号を指定します。 

 「音度 (Degree)」 (「音度」タイプの符頭のみ) は、この符頭を使用する音符の音

度 (1 から 7 の整数) を指定します。 

「符頭 (Notehead)」セクションの下部のアクションバーには以下のボタンがありま

す。 

 「新規の符頭 (New Notehead)」は、デフォルトの黒玉の符頭に基づく「標準 

(Normal)」タイプの新規符頭を作成します。 

 「選択部分から新規作成 (New from Selection)」は、上の「符頭設定 

(Notehead Set)」セクションのグリッドコントロールで選択した符頭と同じタイプと

外観の符頭を新規に作成します。 

 「符頭を編集 (Edit Notehead)」は、符頭そのものの外観を変更できる符頭エディ

ターを開きます。以下を参照してください。 

 「デフォルトとして保存 (Save as Default)」は、選択した符頭をユーザーライブラ

リーに保存し、これ以降に作成するすべての新規プロジェクトで使用できるようにし

ます。 

 「出荷時の設定に戻す (Revert to Factory)」は、内蔵の符頭に対してのみ有効

となります。内蔵の符頭に何らかの変更を加えていた場合は、これによりデフォル

トの状態が復元されます。 
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「符頭を編集 (Edit Notehead)」をクリックすると符頭エディターが開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

画面右側で、さまざまなタイプの要素の中から符頭のデザインに追加するものを選択

します。 

 「グリフ (Glyph)」では、コンピューターにインストールされているすべてのフォント

から文字を追加できます。SMuFL 準拠フォント (Bravura など) を選択している

場合は、「範囲 (Range)」リストに SMuFL 文字の範囲がすべて表示されるので、

文字が見つけやすくなっています。 

 「テキスト (Text)」では、「浄書 (Engrave)」 ▸ 「フォントスタイル (Font Styles)」

に定義されているフォントスタイルを使用して、1 つ以上の文字を追加できます。こ

れを符頭に使用することは稀ですが、選択肢として用意されています。 

 「グラフィック (Graphic)」では、PNG、JPG または SVG 形式のグラフィックを追

加できます。ベクター形式であり、どのサイズでも高解像度で表示される SVG の

使用をおすすめします。 

 「組み合わせ (Composite)」では、プロジェクトにすでに定義されている他の記号

を使用して追加できます。ただし、現時点ではグラフィカルなプレビューが実装され

ていないため、記号の名前を把握している必要があります。 

追加する要素を選択して、現在のパネル下部にある「追加 (Add)」ボタンをクリックす

ると、ディスプレイに要素が追加されます。 

符頭のデザインは、水平方向の原点 (これは符尾が下向きの音符の符尾の位置に

あたります) を表す少し太めの縦のグリッド線に左端が整列され、垂直方向の原点 

(これは譜表線上の符頭に対する譜表線の位置にあたります) を表す少し太めの横

のグリッド線に中央が整列される形で配置します。 
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符尾が上向きの音符の符頭の右側、および符尾が下向きの音符の符頭の左側に、

符尾が接する正確な位置を指定できます。また、符尾を分割したオルタードユニゾン

に符頭が使用される場合、音符に斜めに接する符尾のための追加のアタッチメントポ

イントも指定できます。符尾のアタッチメントポイントを追加または削除するには、符頭

のメインディスプレイの下にある「符尾 (Stem)」ボタンをクリックします。符尾のアタッ

チメントに関する詳細は、以下のリンクより SMuFL の仕様情報をご覧ください。 

https://w3c.github.io/smufl/gitbook/specification/glyphswithanchors.html 
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改善点 
 

オーディオ書き出し 

個々のフローの別々のオーディオファイルへの書き出し、および個々のプレーヤーの

別々のオーディオファイルへの書き出しを行なえるようになりました。また、各フロー

のオーディオファイルを別々のフォルダーに書き出すことができます。これにより、さら

なるミキシングやマスタリングを行なうために、Cubase やその他の DAW にドラッ

グアンドドロップするのに適した「符尾」のエクスポートが素早く簡単に行なえます。

(STEAM-8128) 
 

臨時記号 

臨時記号のタッキングのための切り抜き: 「臨時記号を編集 (Edit Accidental)」ダ

イアログで、記号の 4 隅それぞれの切り抜きが編集できるようになりました。これに

より、隣接する列の臨時記号のタッキングやカーニングをどのように行なうかを 

Dorico に指示できます。(STEAM-8113) 

 

 

 

 

 

 

 

 

 

 

臨時記号の切り抜きを編集するには、ダイアログ下部の「切り抜き (Cut-outs)」タブ

をクリックして、対象となる側の角の「作成 (Create)」ボタンをクリックしてから、緑の

網掛け領域の内側の角のハンドルをクリックして、切り抜きのサイズを変更します。切

り抜きを削除するには、対象となる側の角の「削除 (Delete)」ボタンをクリックします。 

切り抜きに関する詳細は、以下のリンクより SMuFL の仕様情報をご覧ください。 

https://w3c.github.io/smufl/gitbook/specification/bbox-cut-outs.html 
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臨時記号と加線: 加線の左側に臨時記号が付く場合、加線の左側を短くしないように

指定できるようになりました。この動作を有効にするには、「浄書オプション 

(Engraving Options)」の「音符 (Notes)」ページで、「臨時記号が付く音符の加線 

(Ledger lines on notes with accidentals)」を「加線を調整しない (Do not adjust 

ledger lines)」に設定します。これにより、「臨時記号が付く符頭の左側からはみ出る

加線の量 (Ledger lines protrude left of notehead with accidental)」に指定さ

れた値のかわりに、「符頭からはみ出る加線の量 (Ledger lines protrude beyond 

noteheads)」の値が、加線のデフォルトの長さとして使用されます。最も右にある臨

時記号とデフォルトの加線とのデフォルトの間隔は、「浄書オプション (Engraving 

Options)」の「臨時記号 (Accidentals)」ページに新設された「短縮されていない加

線の左側にある場合、最も右の臨時記号の右側との間隔 (Gap to right of 

rightmost accidental, if to left of unshortened ledger line)」オプションにより決

定されます。(STEAM-8179) 

逆向きの音符に付く臨時記号のタッキング: 「浄書オプション (Engraving Options)」

の「臨時記号 (Accidentals)」ページの「間隔 (Gaps)」セクションに、「逆向きの音符

の左側にある場合、最も右の臨時記号の右側との間隔 (Gap to right of 

rightmost accidental, if to left of back note)」オプションが新たに追加されました。

通常、逆向きの音符がある場合でも、臨時記号は通常の余白の幅まで接近が許され

ますが、この値で指定した最小間隔だけは保持されます。(STEAM-6902) 

 

アルペジオ記号 

「浄書オプション (Engraving Options)」の「アルペジオ記号 (Arpeggio Signs)」

ページに、「スラッシュ声部のアルペジオ記号 (Arpeggio signs on slash voices)」

オプションが新たに追加されました。ここでは、スラッシュ付き声部にアルペジオ記号

を表示するかどうかを制御します。デフォルトでは、スラッシュ付き声部に表示される

アルペジオ記号は非常に短いですが、長さは浄書モードで調整できます。 

(STEAM-8180) 
 

小節線 

衝突回避: Dorico は、譜表上のアイテムの位置を決定する際、譜表の上下に突き出

す小節線 (たとえば打楽器インストゥルメント用の 1 線譜における小節線) や反復

記号の羽根 (表示される場合) を常に考慮するようになりました。(STEAM-5752、

STEAM-7413) 
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細 - 細の反復小節線: Dorico 2.0 より導入された讃美歌スタイルへのサポートに伴

い、「浄書オプション (Engraving Options)」の「小節線 (Barlines)」ページの「反復 

(Repeats)」セクションに、「組段開始位置の反復開始線 (Start repeat at start of 

system)」オプションが新たに追加されました。このオプションにより、組段開始位置

の反復開始線で、選択した小節線とリピートの点の両方を表示するか、リピートの点

のみを表示するかを選択できます。(STEAM-7668) 

三重線: 音楽解析において 1 小節より大きな構造上の単位を区切るために使用さ

れる三重線を、[Shift]+[B] のポップオーバーに「triple」と入力することで作成できる

ようになりました。(STEAM-8139) 

 

コード記号 

「浄書オプション (Engraving Options)」の「コード記号 (Chord Symbols)」ページ

の「オルタレーション (Alterations)」セクションに、「オルタレーションに対する臨時記

号の位置 (Position of accidental relative to alteration)」オプションが新たに追

加されました。これにより、Russell Garcia の著作によるシリーズ「The Professional 

Arranger Composer」に推奨される表記法に従う記譜を行なえます。Garcia 氏はコ

ード記号中の音程およびアルタレーションにおいて、水平方向のスペースが節約でき

ることを理由に、臨時記号のかわりにマイナスとプラス記号を使用することを推奨して

います。ただしこれらの記号を使用する場合は、音度に対し通常とは逆の順番で記述

する、つまり「-9」ではなく「9-」と表示することが重要です。マイナス記号またはプラス

記号を音度の前に配置すると、プレーヤーがマイナス記号を短調と解したり、プラス

記号をオーギュメントトライアドと解したりするなど、あいまいさを生じてしまいます。そ

のため新しいオプションにより、必要に応じて臨時記号を音度のあとに表示するよう

指定できるようになりました。(STEAM-8326) 

 

キュー 

リズムによるキュー: リズムによるキューを作成する場合、オクターブ移調楽器にキュ

ーを行なう場合であっても、デフォルトで、オクターブの移調はキューラベルに表示さ

れないようになっています。(STEAM-8339) 

 

ディヴィジ 

組段中のディヴィジのラベル: 「レイアウトオプション (Layout Options)」の「譜表と

組段 (Staves and Systems)」ページに「譜表の上にディヴィジの作成ラベルを表示 

(Show divisi change labels above staves)」オプションが新たに追加されました。

このオプションをオンにすると、各ディヴィジのソリストまたはセクション用に定義され

た譜表ラベルが、それぞれのディヴィジ譜表のディヴィジ開始位置の上に表示され、

これに対応するトゥッティのラベルが、それぞれのディヴィジ譜表のディヴィジ終了位

置の上に表示されます。 

「浄書オプション (Engraving Options)」の「ディヴィジ (Divisi)」ページの新しいオ
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プションにより、組段中のディヴィジ作成のラベルに対し、譜表からのデフォルトの距

離を指定できます。またラベルは、浄書モードで自由に位置を調整したりドラッグした

りできます。また、プロパティパネルの「ディヴィジ (Divisi)」グループに新設された「カ

スタムテキスト (Custom text)」プロパティにより、浄書モードで個々のディヴィジ作

成のラベルの内容を上書きできます。 

(STEAM-8007) 

キャレットの位置にディヴィジを作成する: 音符入力の有効時にディヴィジの変更を作

成できるようになりました。このときディヴィジの変更は、選択の開始位置ではなくキャ

レットの位置に作成されます。(STEAM-8002) 

トゥッティのガイド: ディヴィジ領域を終了させるために「トゥッティに戻る (Restore 

Tutti)」を使用するときに表示されるガイドは、ディヴィジ領域の開始位置と区別がつく

ように「Tutti」とラベルが付くようになりました。(STEAM-8091) 

 

フィルター 

スラッシュ付き声部にフィルターをかける: 「編集 (Edit)」 ▸ 「フィルター (Filter)」 ▸ 

「声部 (Voices)」 ▸ 「すべてのスラッシュ付き声部 (All Slash Voices)」を選択する

か、サブメニューのリストから特定の符尾が上向き、符尾が下向き、または符尾なし

のスラッシュ付き声部を選択することにより、スラッシュ付き声部にフィルターをかけら

れます。(STEAM-8078) 

 

フロー 

フローをトリム: [Shift]+[B] のポップオーバーに「trim」と入力することで、「記譜 

(Write)」 ▸ 「フローをトリム (Trim Flow)」を実行できます。(STEAM-7453) 

 

レイアウト 

デフォルトのパートレイアウト: プロジェクトのパートレイアウトを誤って削除してしまっ

た場合に備え、「設定 (Setup)」 ▸ 「デフォルトのパートレイアウトを作成 (Create 

Default Part Layouts)」コマンドが新たに追加されました。フローごとのプレーヤー

それぞれに 1 つのパートレイアウトを設定できるので、パートレイアウトのデフォルト

のセットを素早く再作成できます。(STEAM-8226) 

 

長休符 

固定幅のタセットバー: 「浄書オプション (Engraving Options)」の「休符 (Rests)」

ページの「長休符 (Multi-bar Rests)」セクションに、「タセットバーの幅 (H-bar 

width)」オプションが新たに追加されました。「固定幅 (Fixed width)」に設定されて

いる場合、タセットバーは、長休符の両側の小節線間に挿入するのではなく、「タセッ

トバーの固定幅 (Fixed H-bar width)」の値を使用して表示されます。

(STEAM-8240) 
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大譜表を用いる楽器の小節数: 出版されている楽譜では通常、ピアノなど大譜表を

用いる楽器における長休符の小節数は 2 つの譜表の間に表示されるだけですが、

ハリウッドの録音セッションに使用されるパート譜では、両方の譜表の上に小節数を

表示するのが一般的です。「浄書オプション (Engraving Options)」の「休符 

(Rests)」ページの「長休符 (Multi-bar Rests)」セクションに新設された「大譜表を用

いる楽器の小節数 (Bar count on grand staff instruments)」オプションにより、こ

れら 2 つの表記規則を使い分けられるようになりました。(STEAM-8342) 

「tacet al fine」のしきい値: 「浄書オプション (Engraving Options)」の「休符 

(Rests)」ページに、「フローの終わりに「tacet al fine」を表示する空白の小節数の最

小値 (Minimum number of bars’ rest at end of flow to show tacet al fine)」

オプションが新たに追加されました。デフォルト値は、新規プロジェクトの場合は 4 小

節、Dorico 2.1 より古いバージョンで作成されたプロジェクトの場合は、外観を保持

するために 1 小節が設定されます。これにより、フローの終わりに極めて短い長休

符しかない場合でも、「tacet al fine」を表示するように指定できます。(STEAM-8238) 

非表示のテンポアイテム: たとえば再生モードのテンポトラックで作成されたものなど、

記譜モードで表示されないテンポアイテムについては、長休符を分割する理由と見な

されなくなりました。(STEAM-8151) 

 

MusicXML の読み込み 

テキストアイテム: 「環境設定 (Preferences)」の「MusicXML の読み込み 

(MusicXML Import)」ページに、「テキストアイテム (Text items)」オプションが新た

に追加されました。これはデフォルトではオフになっています。オンにすると、

MusicXML ファイルに含まれるすべてのテキストアイテムが [Shift]+[X] のテキスト

アイテムとして読み込まれます。これらのテキストアイテムは、テンポや強弱記号など

として読み込まれた他のアイテムと重複する可能性が非常に高くなります。 

(STEAM-8221) 

スラッシュ符頭: Dorico は、有音程楽器と無音程楽器のどちらについても、

MusicXML ファイルからスラッシュ符頭領域とスラッシュ付き声部を適切に読み込め

るようになりました。(STEAM-8212、STEAM-8166) 

小節リピート領域: Dorico は MusicXML ファイルから 1、2 および 4 小節の小節

リピート領域を読み込めるようになりました。(STEAM-7780) 

 

音符 

付点の統合: 「浄書オプション (Engraving Options)」の「音符 (Notes)」ページの

「付点 (Rhythm Dots)」セクションにある「付点の統合 (Rhythm dot 

consolidation)」オプションが改良され、動作がわかりやすくなり、また、対立する声

部でのユニゾンにおける付点の扱いを指定するオプションが追加されました。 
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付点の統合は、隣り合う声部コラムの音程が近い付点音符が一緒に配置され、両方

の声部コラムの右側にそれぞれの付点を 1 列に表示できる状況について、Dorico 

がこれをどのように扱うかを示します。これにより水平方向のスペース使用を効率化

できますが、視覚的に楽譜を読みまちがう原因となる場合があります。Dorico には

付点の統合に関して以下の 3 つの設定が用意されています。 

 「統合しない (Do not consolidate)」は、付点は常にそれが属する音符または和

音のすぐ右側に表示されることを意味します。 

 「同じ長さの音符 (Notes of the same duration)」では、同じ長さを持つ場合に

限り (たとえばどちらも付点 4 分音符の場合。一方が付点 8 分音符でもう一方

が付点 4 分音符の場合はあてはまりません)、隣接するコラムの音符の付点を統

合します。 

 「任意の長さの音符 (Notes of any duration)」では、音価のあらゆる組み合わ

せ (たとえば上向きの声部が 4 分音符で下向きの声部が 2 分音符) で付点を

統合できます。最もコンパクトな配置が実現しますが、読みまちがいのおそれが生

じます。 

これに加え、「対立する声部での付点ユニゾン (Rhythm dots on unisons in 

opposing voices)」オプションが追加されました。これにより、対立する声部における

デュレーションとピッチが同じ 2 つの音符について、付点を 1 つ表示するか、声部

ごとに 1 つずつ表示するかを指定できます。(STEAM-8228) 

付点の水平位置: プロパティパネルの「音符と休符 (Notes and Rests)」グループ

に「付点 X (Rhythm dot X)」プロパティが新たに追加され、浄書モードで付点の水

平位置を調整できるようになりました。複数の音符が同じ位置に存在する場合、この

プロパティは付点のグループ全体に適用されることに注意してください。グループには 

2 つ以上の声部からの音符が含まれる場合があります。(STEAM-8214) 

加線を非表示にする: プロパティパネルの「音符と休符 (Notes and Rests)」グルー

プに「加線を非表示 (Hide stem)」プロパティが新たに追加されました。このプロパテ

ィは浄書モードでのみ表示され、オンにすると音符に伴うすべての加線が非表示にな

ります。(STEAM-8137) 
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ページレイアウト 

「パート形式設定をコピーする (Propagate Part Formatting)」ダイアログが新たに

追加されました。これにより、ページ形式設定およびレイアウトオプションをコピー元レ

イアウトから 1 つ以上の任意のレイアウトにコピーできます。このダイアログを呼び

出すには、設定モードのレイアウトパネル内のレイアウトを右クリックする (選択した

レイアウトがコピー元レイアウトとして選択された状態でダイアログが開きます) か、

設定メニューから選択します。次のようなダイアログが表示されます。 

 

 

 

 

 

 

 

 
 

左側のリストからコピー元レイアウトを選択し、右側のリストから 1 つ以上の任意の

レイアウトを選択します。リストの下の 2 つのチェックボックスは、ダイアログを確定し

たときの動作を決定します。 

 「レイアウトオプションを含める (Include layout options)」は、ページサイズと余

白、デフォルトのマスターページのセット、線間の高さ、垂直方向のスペーシング、

音符のスペーシング、配置設定、長休符の動作、譜表ラベルのオプションなど、主

要なレイアウトオプションをコピー元レイアウトから任意のレイアウトにコピーする

かどうかを指定します。 

 「組段の形式設定を含める (Include system formatting)」は、任意のレイアウト

の各組段に表示する小節数および各フレームに表示する組段数を、コピー元レイ

アウトに合わせるかどうかを指定します。これを実行すると、必要に応じて、それぞ

れの任意のレイアウトの各組段の開始位置に、組段区切りおよびフレーム区切り

が作成されます。任意のレイアウトの既存の組段区切りおよびフレーム区切りは

すべて削除されます。さらに、音符のスペーシングの変更がコピー元レイアウトか

らすべてのレイアウトにコピーされます (コピー先レイアウトの既存の音符のスペ

ーシングの変更はすべて削除されます)。 
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コピー元レイアウトの組段の形式設定がほぼ未編集、または「レイアウトオプション 

(Layout Options)」の「配置設定 (Casting Off)」に依存している場合は、「レイアウ

トオプションを含める (Include layout options)」を使用すれば、各組段に組段区切

りやフレーム区切りを作成しなくても、同じまたはほぼ同じレイアウトが得られるため、

「組段の形式設定を含める (Include system formatting)」オプションを使用する必

要はありません。 

複数の楽曲フレームチェーンを使用する複雑なパートレイアウトは、「パート形式設定

をコピーする (Propagate Part Formatting)」ダイアログのコピー元レイアウトまた

は任意のレイアウトとして適していません。Dorico は、可能な範囲で、コピー元レイア

ウトおよび任意のレイアウトの両方における楽曲フレームのプライマリチェーンの自

動決定を行ないますが、コピー元レイアウトと任意のレイアウトの設定が大きく異なる

場合、期待と異なる結果となる場合があります。特に、浄書モードで行なわれたペー

ジ設定の上書きはコピーされません。 

しかし多くのケースでは、ファミリーまたはセクションの 1 つめのインストゥルメントの

レイアウトをチェックしてから、「パート形式設定をコピーする (Propagate Part 

Formatting)」を使用して残りのレイアウトに変更を素早く適用することで、インストゥ

ルメントパートの形式設定のプロセスに要する時間を大幅に削減できます。

(STEAM-8315) 
 

再生 

バックグラウンドでのサウンドの読み込み: Dorico は、ユーザーインターフェースを停

止させることなく、バックグラウンドで HALion Sonic SE にサウンドを読み込めるよう

になりました。これにより、多くの操作を速やかに行なえます。たとえば、新規プロジェ

クトを開始してプレーヤーを追加する場合、新規プレーヤーそれぞれに必要なサウン

ドはバックグラウンドで読み込まれ、ロードが完了するまで待つことなく他のプレーヤ

ーを追加できるため、操作にかかる時間が大幅に短縮されます。また、既存のプロジ

ェクトを開く場合、すべてのサウンドが読み込まれるのを待つことなく、入力や編集を

即時に行なえます。プロジェクトを切り替える場合も、サウンドがバックグラウンドで読

み込まれるため、新しいプロジェクトでの入力や編集を即時に行なえます。

(STEAM-6471) 

小節リピート記号の再生: 小節リピート記号が自動的に再生されるようになりました。

小節リピート領域の直前にある 1 小節 (1 小節のリピート記号の場合) または複数

小節 (2 小節または 4 小節のリピート記号の場合) が、小節リピート領域のデュレ

ーションに合わせて再生されます。Dorico は、もとの小節内の強弱記号は繰り返さ

ず、小節リピート領域に記譜される強弱記号に従います。(STEAM-7916) 
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非標準の調性システムの再生: Dorico 2.1 は、Dorico 2.0 より採用された微分音の

臨時記号の再生機能を発展させ、12-EDO や 24-EDO に留まらないあらゆる調性

システムにおける微分音の再生を完全にサポートします。Dorico は、HALion ファミ

リーのバーチャルインストゥルメント (バンドル版 HALion Sonic SE 3 を含む) には 

VST3 ノートエクスプレッションを、その他のインストゥルメント (NotePerformer を含

む) には VST2.x ディチューンパラメーターを使用して、音符が臨時記号を伴って記

譜されているかどうかに関わらず、すべての音符に適切なピッチデルタを算出します。

これに加え、「再生オプション (Playback Options)」に新設された「チューニング 

(Tuning)」ページにおいて、再生時の基準ピッチ (デフォルトは 440Hz) を指定でき

るようになりました。(STEAM-7952) 

フレーズとしての段階的強弱記号: Dorico は、近接する複数の同方向の段階的強弱

記号をフレーズとしての強弱記号と解釈し、続けて大きくまたは小さくしていくのでは

なく、段階的強弱記号それぞれの開始位置で、有効な強弱レベルにリセットします。

(STEAM-8220) 

ステレオ出力の選択: 「編集 (Edit)」 ▸ 「デバイス設定 (Device Setup)」ダイアロ

グに「ステレオ出力 (Stereo Output)」コントロールが新たに追加され、Dorico が再

生に使用するオーディオインターフェースのペアを選択できるようになりました。

(STEAM-5176) 

App Nap: App Nap は macOS の節電機能で、バックグラウンドに移行したアプリ

ケーションのプロセッサ使用時間を自動的に抑制して電力使用を削減します。これに

より、再生中に Dorico がバックグラウンドに移行したときに、再生が途切れたり、完

全に停止してしまったりすることがありました。Dorico は今後 macOS に対し、再生

中は App Nap を使用させないように信号を送り、Dorico がバックグラウンドに移行

しても再生を妨げられないようにします。(STEAM-8034) 

 

再生モード 

状態の復元: トラックの展開状態、レーンの垂直サイズ、各オートメーションレーンに

設定されている MIDI コントローラーなどの情報がすべて保存および復元されるよう

になりました。これにより、再生モードから別のモードに切り替え、再び再生モードに

戻っても、これらの設定がすべて保持されます。(STEAM-8100、STEAM-8153) 

特殊トラック: 「再生 (Play)」 ▸ 「トラック (Tracks)」サブメニューが新設され、再生

モードの最初のプレーヤートラックの上に表示させる 4 種類の特殊トラックを選択で

きるようになりました。「タイム (Time)」、「コード (Chords)」、「ビデオ (Video)」、「マ

ーカー (Markers)」の特殊トラックの表示/非表示をそれぞれ個別で設定できます。プ

ロジェクトのフローにビデオが添付されると、「Video」と「Markers」のトラックが自動

的に表示されます。(STEAM-8149) 
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オートメーションの精密制御: 再生モードのテンポまたは MIDI のオートメーションレ

ーンでポイントをドラッグするときに [Alt] キーを押すことで、ポイントを少しずつ移動

できるので、より精密な調整を行なえます。(STEAM-8124) 

トラックのサイズを変更する: 再生モードで、選択したトラックの高さを変更するコマン

ドが新たに追加されました。デフォルトのショートカットは [Shift]+[G] と [Shift]+[H] 

です。 (STEAM-8197) 

無音の再生テンプレート: Dorico が現在のプロジェクトでサウンドを一切読み込まな

いようにする場合は、「再生 (Play)」 ▸ 「再生テンプレート (Playback Template)」

から、新たな再生テンプレート「無音 (Silence)」を選択します。プロジェクトでサウン

ドを再生するには、このダイアログをもう一度開いて、これ以外の再生テンプレートを

適用します。(STEAM-8194) 

MIDI thru で使用するサウンドを選択: 再生モードでトラックヘッダーをクリックすると、

音符入力が無効のときに MIDI キーボードから演奏されたノートのエコーバックに使

用するエンドポイントを設定できます。また、記譜モードで譜表を選択することでもサ

ウンドを変更できます。(STEAM-8201) 

 

演奏技法 

読み込まれたグラフィックを使用する演奏技法は、選択時にオレンジ色の枠線が表示

され、選択状態が確認しやすくなりました。(STEAM-8075) 

 

プロジェクトファイル 

Dorico の旧バージョンで最後に保存されたプロジェクトを開くと、情報メッセージボッ

クスが表示され、プロジェクトが保存された Dorico のバージョンが通知され (特定で

きる場合)、新しいバージョンで開くとプロジェクトが自動的に更新されることが警告さ

れます。プロジェクトは「クリーン」な状態で開かれます。つまり、現バージョンでプロジ

ェクトを開いてすぐに閉じた場合は保存を促しません。これは、このときに行なわれた

更新はすべて、あとでこのプロジェクトをこれ以降のバージョンで再度開いた場合も同

様に行なわれるからです。このメッセージを表示させない場合は、「環境設定 

(Preferences)」の「全般 (General)」ページの「ファイル (Files)」セクションで、「現

バージョンより古いまたは新しいバージョンで保存されたプロジェクトを開くときは警告

する (Warn when opening projects last saved in an earlier or later version)」

をオフにすることで無効にできます。 

Dorico の旧バージョンで最後の保存したプロジェクトを現バージョンで開いたあとで

誤って上書きしてしまわないようにするには、「環境設定 (Preferences)」の同じ場所

にある「現バージョンより古いまたは新しいバージョンから開いたプロジェクトは、新し

い場所に保存することを促す (Prompt to save projects from an earlier or later 

version to a new location)」をオンにします。このオプションがオンになっているとき

は、「ファイル (File)」 ▸ 「保存 (Save)」を選択、または [Ctrl]+[S] (Windows) や 
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[Command]+[S] (Mac) を入力した場合でも、Dorico は自動上書きを行ないませ

ん。かわりに、標準のファイル選択ダイアログが表示され、プロジェクトの新しい名前

と保存場所の選択が促されます。このとき、既存のプロジェクトファイルを上書きする

ことも選択できます。(STEAM-8193) 

 

プロパティ 

「編集 (Edit)」 ▸ 「プロパティをコピー (Propagate Properties)」コマンドが新たに

追加されました。これにより、選択されているアイテムのプロパティを現在のレイアウト

から、そのアイテムが表示される他のすべてのレイアウトにコピーできます。記譜モー

ドで実行した場合、記譜モードのプロパティパネルに表示されるプロパティのみ他のレ

イアウトにコピーされます。浄書モードで実行した場合、記譜モードと浄書モードの両

方のプロパティパネルに表示されるプロパティがコピーされます。 

概して、記譜モードで表示されるプロパティ (すべてのレイアウトに適用されるか、レ

イアウトごとに異なる場合もあるが楽曲フレームのチェーンごとの差異は生じない) 

は、アイテムの意味的な性質を持つ傾向があり、浄書モードにしか表示されないプロ

パティ (通常、レイアウトごとだけではなく、楽曲フレームのチェーンごとにも差異が生

じる) は、精密なグラフィック外観や位置に関わる傾向を持ちます。 

たとえば、スラーの位置とデザイン (実線、破線など) は記譜モードに表示されるプロ

パティであり、記譜モードから「プロパティをコピー (Propagate Properties)」を実行

した場合に適用されますが、スラー終端や制御ポイントの精密な位置は浄書モードに

しか表示されないプロパティであり、浄書モードから「プロパティをコピー (Propagate 

Properties)」を実行した場合のみ適用されます。これにより、すべてのプロパティをコ

ピーするか、各レイアウトの形式設定の詳細に関わらず適用できるものだけコピーす

るかを選択できます。(STEAM-8314) 

 

スラッシュ符頭 

スラッシュ領域の背後の音符を非表示にする: スラッシュ領域では、その範囲内にあ

る他の声部の音符をデフォルトで非表示にしています。これにより、たとえば再生用

にソロの演奏内容を記譜しつつ、スコアおよびパートにはスラッシュのみを表示すると

いうことができます。スラッシュ領域に他の声部を表示させる必要がある場合は、プロ

パティパネルの「スラッシュ領域 (Slash Region)」グループで「他の声部を表示 

(Show other voices)」プロパティをオンにします。(STEAM-8138) 

スラッシュ領域の小節数: 「浄書オプション (Engraving Options)」の「音符 

(Notes)」ページに新設された「小節数 (Count)」セクションに、スラッシュ領域の小節

数を表示するオプションが新たに追加されました。 

 「スラッシュ領域の小節数を n 小節ごとに表示 (Show slash region bar count 

every n bars)」では、小節数を表示する間隔を指定します。これを「1」に設定する

と、すべての小節に小節数が表示されるようになります。  
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 「スラッシュ領域の小節数の外観 (Appearance of slash region bar count)」で

は、小節数をどのように表示するかを指定します。「括弧つき (With 

parentheses)」、「括弧なし (Without parentheses)」、「非表示 (Do not 

show)」のいずれかを選択します。 

 「スラッシュ領域の小節数の位置 (Placement of slash region bar count)」で

は、小節数を譜表の上または下のどちらに表示するかを決定します。 

 「譜表からの小節数の距離 (Bar count distance outside staff)」では、譜表の

上端または下端から小節数の数字までの距離を指定します。 

浄書モードでは、必要に応じて小節数の数字の位置を調整したりドラッグしたりできま

す。(STEAM-8114) 

 

譜表ラベル 

譜表ラベルに使用するリッチテキスト: 「インストゥルメント名を編集 (Edit 

Instrument Names)」ダイアログに、譜表ラベルのより複雑な形式設定を行なうため

のコントロールが追加されました。所定のインストゥルメントの余白部分に表示される

譜表ラベルを編集するには、設定モードのプレーヤーパネルでそのインストゥルメント

が割り当てられているプレーヤーのカードを展開します。インストゥルメント名にマウス

カーソルを置いて山括弧「>」を表示させ、「>」をクリックします。コンテキストメニューか

ら「名前を編集 (Edit Names)」を選択します。次のようなダイアログが表示されま

す。 
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このダイアログに入力されたテキストは、譜表左側の余白に表示される譜表ラベルだ

けでなく、譜表上部のインストゥルメントの変更ラベルにも使用されますが、この場合、

改行や段落はすべて削除されて、ラベルが 1 行にまとめられます。さらに、ダイアロ

グの配置に関する指定は無視されます。かわりに、パラグラフスタイルの配置が常に

使用されます。これにより、組段の上から下まで、譜表ラベルの配置の一貫性を確保

できます。 

インストゥルメントのラベルをデフォルトに復元するには、「デフォルトにリセット 

(Reset to Default)」をクリックします。(STEAM-8273) 

譜表のグループラベル: 「浄書オプション (Engraving Options)」の「譜表ラベル 

(Staff Labels)」ページに「隣接する同じソロ楽器の譜表ラベル (Staff labels for 

identical adjacent solo instruments)」オプションが新たに追加されました。「譜表

間のグループ化 (Group between staves)」に設定すると、同じインストゥルメントに

属した隣接する譜表すべてに対し、1 つのインストゥルメント名が中央揃えで配置さ

れます。たとえば 2 つのフルートパートの場合、「Flute」ラベルが 2 つの譜表間に

中央揃えで配置され、上の譜表には「1」、下の譜表には「2」のラベルが付きます。 

グループラベルは、同じインストゥルメントに属する譜表全体に対し中央揃えで配置さ

れます。譜表の数が奇数の場合、グループラベルは真ん中の譜表の第 3 線に、偶

数の場合は真ん中の 2 つの譜表間のスペースに、中央揃えで配置されます。 

インストゥルメント番号およびディヴィジセクションには新しいパラグラフスタイルである

「譜表ラベル (内) (Staff labels (inner))」が使用され、グループ化なしのインストゥル

メント、グループのラベル、およびディヴィジのグループまたはプレーヤーのラベルに

は、従来の「譜表ラベル (Staff labels)」のスタイルが使用されます。次の図は、どの

種類のラベルがどのパラグラフスタイルを使用するかを示します。 

  

譜表ラベル 

譜表ラベル(内) 
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組段の小節線と内側および外側の譜表ラベルとの距離は、「浄書オプション 

(Engraving Options)」の「譜表ラベル (Staff Labels)」ページの「組段の開始位置 

(Start of System)」オプションを使用して決定されます。(STEAM-8324) 

フローの開始位置のラベル: プレーヤーに複数のインストゥルメントが割り当てられて

いる場合、プレーヤーは、各楽章の開始時にどのインストゥルメントを演奏すべきかを

把握しておくことが重要です。フルスコアレイアウトでは、通常最初の組段の左側に譜

表レベルが表示されますが、パートレイアウトでは通常表示されません。「レイアウト

オプション (Layout Options)」の「プレーヤー (Players)」ページの「インストゥルメ

ントの変更 (Instrument Changes)」セクションに、「フローの開始位置にインストゥ

ルメントの変更ラベルを表示 (Show instrument change label at start of flow)」

オプションが新たに追加されました。このオプションは、新規プロジェクトのパートレイ

アウトではデフォルトでオンになっていますが、Dorico 2.0 以前のバージョンで作成さ

れたプロジェクトでは、外観を保持するためにオフになっています。オンにすると、最

初の小節の開始位置にインストゥルメントの変更ラベルが表示され、プレーヤーはど

のインストゥルメントを演奏すべきかがわかりやすくなります。(STEAM-8242) 

ディヴィジのグループラベル: 「ディヴィジを作成 (Change Divisi)」ダイアログの「プ

レーヤー名またはグループ名を表示 (Show player or group name)」オプションは、

「レイアウトオプション (Layout Options)」の「譜表と組段 (Staves and Systems)」

ページのオプションより優先されるようになりました。ディヴィジのグループ名は、ディ

ヴィジにグループ名が定義されていない場合は、分割された組段の外側の譜表レベ

ルに表示されるデフォルトのインストゥルメント名になります。設定されている場合は、

ディヴィジのグループ名が表示されます。(STEAM-8070) 

 

組段の分割記号 

組段の分割記号を (フローに一定数以上の譜表が含まれる場合ではなく) 譜表の数

が異なる組段同士の間にのみ表示するように指定できます。これはハリウッドのレコ

ーディングセッションのために作成されるパート譜で使用される表記規則です。この動

作を有効にするには、「レイアウトオプション (Layout Options)」の「譜表と組段 

(Staves and Systems)」ページの「組段の分割記号 (System Dividers)」セクショ

ンで、「組段の分割記号を表示 (Show system dividers)」を「譜表の数が異なる場

合 (When number of staves differs)」に設定します。「プレイヤーの最小数が存

在する場合 (When minimum number of players present)」を選択すると、従来

のデフォルトの動作となります。(STEAM-8349) 
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拍子記号 

大きな拍子記号: 無音程打楽器および鍵盤楽器のグループに 1 つの拍子記号を表

示するオプションが改善され、金管楽器と弦楽器の間のあらゆるファミリーに属する

すべてのインストゥルメントをグループ化して、1 つの大きな拍子記号を表示できるよ

うになりました。この変更により、オプションの表記が「金管楽器および弦楽器の間の

インストゥルメント (Instruments between brass and strings)」、選択肢が「個別

に扱う (Treat separately)」と「単一の大括弧として扱う (Treat as single bracket)」

に変更されました。(STEAM-7726) 

空白の拍: [Shift]+[M] のポップオーバーに「open」と入力すると、記号を表示しない

空白の拍を作成できます。(STEAM-8150) 

 

連符 

連符の数字のフォント選択: 「浄書オプション (Engraving Options)」の「連符 

(Tuplet)」ページの「連符の数字のスタイル (Tuplet digit style)」オプションに、「プ

レーンフォント (Plain font)」の選択肢が新たに追加されました。このオプションを選

択すると、使用中の音楽フォント (デフォルトでは Bravura) による伝統的な太字ま

たは細字の数字のかわりに、「浄書 (Engrave)」 ▸ 「フォントスタイル (Font 

Styles)」の「連符のプレーンフォント (Tuplet plain font)」で指定されるテキストフォ

ントが使用されます。(STEAM-8218) 

連符の角括弧のフックの位置: 「浄書オプション (Engraving Options)」の「連符 

(Tuplets)」ページの「水平位置 (Horizontal Position)」セクションに、「角括弧の開

始位置と終了位置のオフセット (Offsets for Start and End of Bracket)」という見

出しのもと 2 つの新たなオプションが追加されました。ここでは、連符の角括弧の右

側と左側のスペースのデフォルト値を設定できます。「符尾が下向きの連符に付く角

括弧の開始位置の追加オフセット (Additional offset for start of bracket on 

stem- down tuplets)」の値は、連符に角括弧が表示され、符尾が下向きである場

合のみ使用され、「符尾が上向きの連符に付く角括弧の終了位置の追加オフセット 

(Additional offset for end of brackets on stem-up tuplets)」の値は、連符に角

括弧が表示され、符尾が上向きである場合のみ使用されます。既存のプロジェクトの

場合は、外観が変わってしまうことを防ぐため、値は 0 に設定されています。新規プ

ロジェクトの場合は 1/4 に設定されています。(STEAM-8087) 

  



 

Dorico 2 バージョン履歴 25ページ Steinberg Media Technologies GmbH 

 

ユーザーインターフェース 

キーボードショートカット: 「環境設定 (Preferences)」の「キーボードショートカット 

(Key Commands)」ページの「編集 (Edit)」カテゴリーに 3 つのコマンドが新たに

追加され、レイアウトに関連する一般的な操作について、メニューやダイアログを開く

ことなく、キーボードショートカットで直接実行できるようになりました。 

 「小節の統合を変更 (Change Bar Consolidation)」は、複数小節のリピートの

表示に関する 3 つの状態 (統合なし、長休符のみ、長休符と小節リピート記号) 

それぞれについて特定のキーボードショートカットを設定できます。 

 「小節の統合を切り替え (Toggle Bar Consolidation)」には 1 つのキーボード

ショートカットを設定でき、繰り返し実行すると 3 つの状態が順番に切り替わりま

す。 

 「レイアウトの移調を切り替え (Toggle Layout Transposition)」には 1 つのキ

ーボードショートカットを設定でき、繰り返し実行すると、「編集 (Edit)」 ▸ 「移調ピ

ッチ (Transposing Pitch)」と「編集 (Edit)」 ▸ 「コンサートピッチ (Concert 

Pitch)」の間で切り替わります。(STEAM-8239) 

トラスポートの表示: ツールバーのミニトランスポート内のタイムディスプレイをクリック

すると、小節.拍.ティック、経過時間、タイムコードの順に、読み出し値の表示が切り替

わるようになりました。メイントランスポートウィンドウでは、右側のタイムディスプレイ

をクリックすると、経過時間とタイムコードが順に切り替わります。(STEAM-8115) 

ウィンドウサイズと位置の復元: 以前に保存したプロジェクトを再度開くとき、保存した

ウィンドウのサイズと位置をより高い信頼性で復元できるようになりました。

(STEAM-3213) 
 

ビデオ 

見つからないビデオファイルの位置検索: ビデオが添付されたプロジェクトを開くとき、

プロジェクトに指定されるもとの位置にビデオが見つからない場合、Dorico は 

Dorico プロジェクトに伴うフォルダーでビデオファイルを検索して、発見した場合は自

動的に再添付を行ないます。(STEAM-7897) 

Apple ProRes ビデオ: Apple の ProRes コーデックを使用するビデオは、ProRes 

コーデックが Dorico 向けに配布されたことにより、正常に再生されるようになりまし

た (このコーデックは Windows でのみ必要。Mac では別個のコーデックがなくても、

ProRes ファイルを再生できます)。(STEAM-8177) 
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Issues resolved 

ID # Component Issue 

STEAM-5341  Accidentals  
Changing the enharmonic spelling of a note with a microtonal accidental now works 

reliably.  

STEAM-7506  Accidentals  
A number of problems relating to the choice of specific accidental in note input when 

multiple accidentals in the tonality system have the same pitch delta have been 

resolved.  

STEAM-8133  Accidentals  
It is once again possible to select the symbols in the Edit Accidental dialog with the 

mouse.  

STEAM-7673  Articulations  Staccato articulations are now positioned correctly under slurs on beamed grace notes.  

STEAM-8174  Audio engine  
Switching away from Dorico while it is starting up with the Suspend audio engine in 

background preference enabled no longer sometimes causes it to hang (Mac only).  

STEAM-8162  Audio export  
Attempting to switch to another open project while exporting audio from the first no 

longer causes a crash.  

STEAM-8227  Barlines  
Start repeat barlines now appear correctly at the start of the system if they coincide with 

a time signature that is set to appear above the staff.  

STEAM-8143  Bars  
When deleting bars at the end of the project, Dorico now ensures that tempos, rehearsal 

marks, note spacing changes and breaks in the deleted range are correctly removed.  

STEAM-5767  Beaming  
Further improvements have been made to Dorico’s algorithms for avoiding “beam 

corners” when beaming between notes on different staves.  

STEAM-8148  Beaming  
Under some circumstances, stems on notes crossed between staves could appear on 

the wrong side of the notehead when reopening an existing project; this is now fixed.  

STEAM-5767  Beams  
A problem that caused beam corners (where a partial beam is positioned on the wrong 

side of a between-staves beam) to appear for some rhythmic patterns has been fixed.  

STEAM-8204  Beams  
A problem whereby noteheads could draw on the wrong side of notes when crossed to 

other staves when first opening an existing project has been fixed.  

STEAM-8156  Breaks  
Moving a system or frame break signpost with Alt+left/right no longer causes the 

signpost to be removed altogether.  

STEAM-8098  Chord symbols  Chord symbols no longer incorrectly appear on extra staves added to instruments.  

STEAM-8213  Chord symbols  
Chord symbols now correctly cause multi-bar rests to split on grand staff instruments 

where one staff is hidden because it is empty.  

STEAM-8022  Clefs  
A problem whereby redundant clefs appear in extra staves belonging to an instrument 

has been fixed.  

STEAM-8069  Clefs  
Dorico no longer shows restorative clefs and key signatures at the end of a tutti passage 

at the end of a system belonging to the divisi staves that were present earlier in the 

system.  

STEAM-8023  Divisi  
Staves in galley view will no longer be spaced sufficiently far apart to make room for all 

divisi staves, when the last divisi change has been deleted from a section player.  

STEAM-8071  Divisi  
Time signatures at the end of a system that coincides with the end of a tutti range 

(following the end of a divisi section on that system) now appear reliably in all staves.  
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ID # Component Issue 

STEAM-8085 Divisi 
Changes of key signature in unison ranges before or after a divisi change on a system 

no longer collide with the double barline after reopening the project. 

STEAM-8223  Divisi  
Key signatures on divided transposing instruments in the preamble at the start of the 

system now always show the correct transposition.  

STEAM-8284  Divisi  
Disabling instrument changes for a given layout no longer causes the staff labels for 

divisi staves to stop appearing correctly.  

STEAM-8288  Divisi  
Pasting a divisi event that references a custom paragraph style into another project no 

longer causes a crash.  

STEAM-8322  Divisi  
Under some circumstances, pasting a divisi signpost could cause Dorico to crash; this is 

now fixed.  

STEAM-7942  Dynamics  
Dynamics will no longer sometimes be positioned incorrectly in galley view after editing 

them, e.g. changing their placement.  

STEAM-8254  Dynamics  
The cresc./dim. gradual dynamics in the Dynamics panel are no longer incorrectly 

shown as hairpins in additional windows opened for a project.  

STEAM-8325  Dynamics  
Under some circumstances, edits to notes on one system could cause dynamics on the 

previous system to change position incorrectly; this has now been fixed.  

STEAM-8068  Flows  Playback is now always initialised correctly when importing flows into an empty project.  

STEAM-8095  Flows  
Splitting an existing flow no longer causes notes on the left-hand staff of a piano 

instrument to be moved incorrectly to the right-hand staff in the new flow.  

STEAM-8103  Flows  
Layouts that contain only a subset of flows now play back correctly, and can be 

exported as audio correctly.  

STEAM-8282  Flows  
Improvements to the handling of players with multiple identical instruments when 

importing flows.  

STEAM-7482  
Graphics 

import  
Graphics files imported from OneDrive using the “on-demand files” feature now appear 

correctly (Windows only).  

STEAM-8183  
Holds and 

pauses  
Caesuras that are not positioned immediately before a note, rest or barline no longer 

cause an unexpected spacing distortion at the following barline.  

STEAM-8183  
Holds and 

pauses  
A caesura positioned at an arbitrary rhythmic position within a bar no longer causes the 

spacing of a time signature at the start of the following bar to be incorrect.  

STEAM-8085  
Key 

signatures  
Key signatures no longer incorrectly collide with double barlines to their left when they 

appear within a tutti range preceding or following a divisi change.  

STEAM-8208  
Key 

signatures  
Under rare circumstances, defining a tonality system with specific combinations of 

divisions could cause a crash; this has now been resolved.  

STEAM-8223  
Key 

signatures  
Key signatures in divisi staves are now always correctly transposed if required in a 

transposing layout.  

STEAM-8279 Layouts 

Reset to Factory in Layout Options now restores staff label options to the correct 

values for parts in part layouts; previously it was incorrectly using the defaults for full 

scores.  
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ID # Component Issue 

STEAM-8267 MIDI import  
A problem whereby shorter notes contained entirely within the duration of longer notes 

on the same instrument would be omitted when importing MIDI files has been fixed.  

STEAM-8296  MIDI import  
The last note in a MIDI file is no longer sometimes incorrectly omitted if its duration is 

shorter than a quarter note (crotchet).  

STEAM-8178  Mixer  
For some projects, the initial displayed position of the Video fader in the Mixer did not 

match its actual output level when first opened; this problem has now been resolved.  

STEAM-8083  
Multi-bar 

rests  

Edits to grace notes close to divisi change events no longer sometimes result in 

multi-bar rests being split incorrectly.  

STEAM-8121  
Multi-bar 

rests  

Multi-bar rests no longer disappear at transitions between instruments when the player 

has local time signature changes.  

STEAM-8144  
Multi-bar 

rests  

Creating a system break following a divisi change no longer incorrectly causes multi-bar 

rests to be split.  

STEAM-8164  
Multi-bar 

rests  

Divisi changes belonging to players who are cued into the current layout no longer 

incorrectly cause multi-bar rests to be split.  

STEAM-5809  
MusicXML  

import  

Transposing instruments created via MusicXML import are now correctly numbered, 

taking their transposition into account.  

STEAM-7884  
MusicXML  

import  

Switching off the Beam groups option on the MusicXML Import page of Preferences 

now correctly takes effect for all noteheads within a tie chain.  

STEAM-8122  
MusicXML  

import  

Some specific combinations of coincident tuplets in MusicXML files exported from Finale 

could cause Dorico to crash; this has now been fixed.  

STEAM-8203  
MusicXML  

import  

Importing a MusicXML file into an existing empty project no longer results in some of the 

required default notehead types being missing from the project.  

STEAM-8256  
MusicXML  

import  

Under some circumstances, the import of nested tuplets in MusicXML files could fail. 

This problem has now been fixed.  

STEAM-5625  Note input  
The default enharmonic spelling chosen for grace notes now matches the spelling 

chosen for normal notes.  

STEAM-7113  Note input  
It is no longer possible to input notes on a staff not currently visible (e.g. an extra staff, 

ossia, or divisi staff, or a staff belonging to another instrument held by the same player.)  

STEAM-7493  Note input  
It is now possible to lengthen or shorten the duration of an implicit rest repeatedly 

without needing to reselect the rest after each edit.  

STEAM-7506  Note input  
The input of accidentals with equivalent pitch deltas in tonality systems that define 

multiple such accidentals has been substantially improved.  

STEAM-7585  Note input  Multi-paste now works reliably when copying material crossed from one staff to another.  

STEAM-7585  

STEAM-8167  
Note input  

Under some circumstances, cross-staff notes could be pasted onto the wrong staff; this 

problem has now been resolved.  

STEAM-7852 Note input  
After using Edit ▸ Paste Special ▸ Move to Staff Above/Below, rests that were moved 

as part of the selection now correctly remain selected. 
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ID # Component Issue 

STEAM-8021 Note input  
Slurs that end at tuplet positions are no longer incorrectly unscaled when using Edit ▸ 

Paste Special ▸ Reduce.  

STEAM-8066  Note input  
Copying and pasting material between instruments with differing numbers of staves now 

works correctly.  

STEAM-8082  Note input  
Attempting to change existing notes into a slash voice no longer sometimes causes 

Dorico to crash.  

STEAM-8086  Note input  
Copying and pasting between instruments with different numbers of staves, or between 

divisi staves and regular staves, now works as expected.  

STEAM-8105  Note input  
Copying and pasting an ossia or extra staff signpost from one instrument to another now 

correctly creates additional staves if necessary.  

STEAM-8134  Note input  Grace notes are now handled correctly by Edit ▸ Paste Special ▸ Explode.  

STEAM-8147  Note input  
Edit ▸ Paste Special ▸ Explode now works correctly if invoked on a staff that contains 

both notes and dynamics.  

STEAM-8249  Note input  
The enharmonic spellings chosen for octave-transposing instruments no longer 

unexpectedly differ for non-octave-transposing instruments.  

STEAM-8262  Note input  
It is no longer possible to use N/M to cause notes to disappear because they have been 

crossed to an ossia or extra staff that is not visible at the selected rhythmic position.   

STEAM-8263  Note input  
Inputting notes via MIDI keyboard into a new voice now always produces the expected 

enharmonic spelling.  

STEAM-8270  Note input  
The notes input on one instrument no longer incorrectly affect the enharmonic spellings 

chosen for notes input on another instrument during the same input session.  

STEAM-8289  Note input  Divisi, ossia and extra staff signposts are now excluded from block selection.  

STEAM-8297  Note input  
Using Alt+N/M to move items to the staff above or below no longer incorrectly attempts 

to move pedal lines or divisi/ossia/extra staff signposts.  

STEAM-8298  Note input  
Setting articulations and accidentals before specifying the pitch of the grace note to be 

input now works correctly.  

STEAM-8319  Note input  
Edit ▸ Paste Special ▸ Move to Staff Below (Alt+M) now correctly always moves to the 

next staff when the selection being moved is not on the first staff of an instrument.  

STEAM-8329  Note input  
Starting note input via the mouse by clicking the Lock Duration button in the note input 

toolbox now works correctly.  

STEAM-6975  Notes  
Under some circumstances, it was possible for a note’s rhythm dot to be shown twice 

when the note is consolidated with a voice column to its left; this is now fixed.  

STEAM-7665  Ornaments  

Under some circumstances, single-stem tremolo slashes could collide with noteheads 

because the stem was insufficiently lengthened; this has now been fixed (Windows 

only).  

STEAM-8206 Ossias 
When an ossia is active on a grand staff instrument, only one of the main staves can be 

hidden if empty, rather than allowing all regular staves of the instrument to be hidden. 
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ID # Component Issue 

STEAM-8063 Page layout  
A problem whereby editing the position of a tempo mark could cause the vertical spacing 

to change unexpectedly has been resolved.  

STEAM-8092  Page layout  
Hiding empty staves now once again works correctly for players holding multiple 

instruments in layouts in which instrument changes are disabled.  

STEAM-8165  Page layout  
Spurious additional clefs and key signatures no longer sometimes appear in the middle 

of the system when extra staves are set via layout options to start at system breaks.  

STEAM-8200  Page layout  
Changes made to staff spacing for extra staves belonging to an instrument are now 

persisted correctly when saving and reopening a project.  

STEAM-8243  Page layout  
Under some circumstances, moving a rehearsal mark in Engrave mode could cause a 

tempo mark on another system to move; this is now fixed.  

STEAM-8277  Page layout  
Under some circumstances, repitching music could incorrectly cause lyrics above the 

staff to move further away from the staff; this is now fixed.  

STEAM-8278  Page layout  

Under some circumstances, editing or inputting notes directly before a multi-bar rest 

could cause the bar count number to move incorrectly away from the staff; this is now 

fixed.  

STEAM-8287  Page layout  
It is now possible to select the staff spacing handles for multiple instruments held by the 

same player independently when instrument changes are not shown for a layout.  

STEAM-8312  Page layout  
A series of fermatas positioned on adjacent barlines no longer sometimes move 

incorrectly when one of the fermatas is nudged in Engrave mode.  

STEAM-8251  Percussion  
Under rare circumstances it was possible for Dorico to crash when editing the names of 

instruments in a percussion kit from the Edit Percussion Kit dialog. This is now fixed.  

STEAM-8157  Performance  
The speed of inputting notes in projects that include changes in the number of staves for 

an instrument has been improved.  

STEAM-8246  Performance  
The speed of inputting and editing music in larger projects with percussion kits shown 

using the grid presentation type has been improved.  

STEAM-8268  Performance  The speed of note input in larger projects with instrument changes has been improved.  

STEAM-8103  Play mode  
A problem whereby layouts that do not have all flows attached could play back with long 

periods of silence has been resolved.  

STEAM-8174  Play mode  
A problem that could cause Dorico to hang during start-up if the Suspend audio device 

in background preference was set has been fixed (Mac only).  

STEAM-8285  Play mode  
The correct VST Expression Map is now chosen by default when creating a solo double 

bass player when using the HALion Symphonic Orchestra playback template.  

STEAM-7989  
Playing 

techniques  

Adding an ossia staff above the right-hand staff of a piano no longer incorrectly causes 

pedal lines to stop drawing.  

STEAM-8224  
Playing 

techniques  

Under some circumstances, pedal lines would draw on the top staff in the system in 

galley view; this is now fixed.  

STEAM-8327 
Playing 

techniques  

Editing the default placement of a playing technique in Engrave ▸ Playing Techniques 

now correctly updates any existing playing techniques in the score right away.  
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ID # Component Issue 

STEAM-8136 Print mode  
Lyrics colored by View ▸ Notes and Rests ▸ Voice Colors are no longer incorrectly 

displayed in color in Print mode.  

STEAM-8198  Print mode  
Commands from the Edit menu that can edit the score are now correctly disabled in 

Print mode.  

STEAM-7482  Project files  
Importing a graphic located in OneDrive when using the files on-demand setting now 

works correctly (Windows only).  

STEAM-8195  Project files  
Improvements have been made to the way that Dorico determines the filename to be 

used when exporting multiple flows to a new project.  

STEAM-2812  Setup mode  
Under certain circumstances, dragging an instrument from one player to another in the 

Players panel could cause a crash; this is now fixed.  

STEAM-8269  Setup mode  
Changing the instrument held by a player from one kind to another no longer incorrectly 

changes any slash voices in that instrument’s music into regular voices.  

STEAM-7501  Slurs  
Creating a slur with a single note selected now always correctly advances the slur to the 

next note of a different pitch, instead of ending at the end of the current note if it is tied.  

STEAM-7674  Slurs  The positioning of slurs on grace notes in multiple voice contexts has been improved.  

STEAM-8241  Slurs  
Attempting to create and extend a slur with the mouse when more than one window is 

open on the project no longer causes an error message to appear.  

STEAM-8155  System track  The appearance of the system track in music in open meter has been improved.  

STEAM-8190  System track  The system track now draws correctly for bars that span more than one system break.  

STEAM-8271  Text  
The values for the default distance of text items from the staff were incorrect by half a 

space; this has now been corrected.  

STEAM-8320  Text  
Clicking Revert to Factory for one of default paragraph styles in Engrave ▸ Paragraph 

Styles, no longer causes problems displaying items in the score or even a crash.  

STEAM-8033  
Time 

signatures  

Time signatures local to a single staff now draw correctly when global time signatures 

are set to draw outside the staff.  

STEAM-8227  
Time 

signatures  

Start repeat barlines now appear correctly at the start of the system when they coincide 

with a time signature change, and the time signature is shown outside the staff.  

STEAM-8110  User interface  
It is once again possible to define shortcuts for commands nested two levels deep in the 

Key Commands editor, e.g. for articulations, note durations, and so on.  

STEAM-8129  User interface  
The state of the various buttons in the user interface concerning the Video window now 

always correctly stay in sync.  

STEAM-8185  User interface  
Navigating through the entries in the drum map with the arrow keys now correctly 

updates the selection in the panel at the bottom of the Percussion Maps dialog.  

STEAM-8219 User interface  
Some list controls in Dorico incorrectly caused the Input Method Editor for CJK text input   

to become activated; this has now been fixed (Windows only). 
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ID # Component Issue 

STEAM-8260 User interface  
Under some circumstances, the instrument labels in expanded player cards in the 

Players panel in Setup mode would stop drawing; this is now fixed.  

STEAM-8332  User interface  
The Stereo output and Sample rate controls in Edit ▸ Device Setup no longer flicker 

when changing values.  

STEAM-8090  Video  There is no longer a limit on the length of the path of an attached video file.  

STEAM-8093  Video  
Changing the project frame rate via the Video Properties dialog now always correctly 

sets timecode offsets for the current flow.  

STEAM-8132  Video  
Advancing the playhead position frame by frame now always displays the correct 

timecode in a newly-created project.  

STEAM-8178  Video  
The position of the video fader in the Mixer is now always correct when opening an 

existing project.  

STEAM-8235  Video  Dorico now always correctly detects the framerate of a video at 23.976fps.  

STEAM-8101  Views  
The presence of a timecode staff no longer causes staves to become misaligned in 

galley view in projects in which instruments have a variable number of staves.  

STEAM-8171  Views  
Staff labels shown in the margin in galley view no longer disappear for a moment at 

certain points when scrolling music left and right.  

STEAM-8176  Views 
When multiple windows are open on the same project, only the window in focus will 

follow changes of selection.  
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Dorico 2.0 
 

 

2018 年 5 月 30 日 

このバージョンの新機能、改善点および解決済みの問題を以下に記載します。 

 
 

新機能 
 

ビデオ、マーカーおよびタイムコード 

Dorico 2 はついに Cubase および Nuendo と同じ高性能ビデオエンジンを搭載し

ました。タイムコード、マーカーおよびテンポの管理機能一式も備えて、画像に合わせ

た楽曲の構成の新たな可能性を広げます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

サポートされているビデオ形式: 昨年より、従来の 32 ビット版 QuickTime ベース

のエンジンにかわって Cubase/Nuendo のビデオエンジンが導入され、今では一般

的に使用されているビデオ形式の大部分をサポートし、将来はさらに多くのフォーマッ

トのサポートを予定しています。 

MOV および MP4 コンテナは H263 と H264 のビデオをサポートし、MOV コン

テナは Apple ProRes、DV/DVCPro および Avid DNxHR コーデックをサポートし

ます。AVI コンテナは、DV/DVCPro および MJPEG/PhotoJPEG をサポートします。

可変フレームレートのビデオはサポートされていませんが、一般的なフレームレート 

(23.976、24、24.975、25、29.97、および 30 フレーム/秒) はすべて完全にサポー

トされています。 

サポートされているビデオ形式の詳細について、およびビデオに使用されるビデオ形

式の特定とサポートされている形式へのコード変換の方法については、Steinberg 

のサポートサイトをご覧ください。 
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https://helpcenter.steinberg.de/hc/en-us/articles/115000808250-Video-support-in
-Cubase-and-Nuendo 

 

ビデオの添付: プロジェクトの各フローにビデオを添付できます。長いビデオ (たとえ

ばフィルム丸 1 巻分) で作業する場合、そのビデオを複数のフローに添付して、フロ

ーごとにそれぞれ異なる場面に合わせて作業できます。ビデオの添付には以下の 2 

つの方法があります。 

 設定モードで、フローパネルからビデオを添付するフローを右クリックして、コンテ

キストメニューから「ビデオ (Video)」▸「添付 (Attach)」を選択します。ファイル選

択ダイアログが表示され、そこから添付するビデオを選択できます。「開く (Open)」

をクリックすると、ビデオがプロジェクトに添付されます。 

 再生モードで、ビデオが格納されているフォルダーからビデオファイルをドラッグし

て、タイムライン上のビデオを添付する位置にドロップします。 

設定モードでビデオを添付した場合、「ビデオのプロパティ (Video Properties)」ダイ

アログが開き、以下のオプションが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 「ビデオファイル (Video file)」および「ビデオのフレームレート (Video frame 

rate)」は書き込み不可のフィールドとなっており、添付ビデオファイルの絶対パス

と、ビデオエンジンが検出したフレームレートが表示されます。 

 「プロジェクトのフレームレート (Project frame rate)」は、マーカーおよびトランス

ポートウィンドウに表示するタイムコードを決定するために Dorico が使用するフ

レームレートを指定します。「ビデオのフレームレートを使用 (Use video frame  

rate)」をクリックすると、ビデオエンジンが検出したフレームレートが設定されます。

利用できるフレームレートの詳細については、以下を参照してください。 

 「フローのアタッチメント位置 (Flow attachment position)」では、フロー内のビ

デオの再生開始ポイントを指定します。これは指定した単位の拍の倍数で指定し

ます。 

たとえば、4/4 のフローの最初の 2 小節にはビデオを再生させない場合、「拍の

https://helpcenter.steinberg.de/hc/en-us/articles/115000808250-Video-support-in-Cubase-and-Nuendo
https://helpcenter.steinberg.de/hc/en-us/articles/115000808250-Video-support-in-Cubase-and-Nuendo
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カウント (Beat count)」フィールドに 8 を入力し、「拍の単位 (Beat unit)」から 

4 分音符を選択します。 

 「ビデオ開始オフセット (Video start offset)」では、フローのアタッチメント位置で

表示されるビデオのフレームを指定します。たとえばビデオの 6 フレームめまで

無音が要求される場合、このフィールドに「00:00:00:06」と入力することで、ビデオ

の再生が 6 フレームめから開始するように指定します。 

 「タイムコード開始 (Timecode start)」では、フローのアタッチメント位置における

タイムコードの値を指定します。たとえば、フィルム 1 巻ごとの開始位置には 1 

時間区切りのタイムコードが付与される慣習があります。つまり、1 巻めは通常 

「01:00:00:00」から開始し (「10:00:00:00」から開始する場合もある)、2 巻めは 

「02:00:00:00」 (または「11:00:00:00」) から開始する、といった具合です。 

すべてのプロパティの設定を終えたら、「OK」をクリックします。 

再生モードでビデオを添付した場合、「ビデオのプロパティ (Video Properties)」ダイ

アログが自動的に開くことはありません。設定モードでフローのカードを右クリックして、

コンテキストメニューから「ビデオ (Video)」▸「プロパティ (Properties)」を選択する

か、記譜モードでマーカーパネルの上部にある「ビデオのプロパティ (Video 

Properties)」ボタンをクリックすると、ダイアログが開きます。 

 

ビデオを添付すると、設定モードのフローパネルにあるフロー

のカードの左下隅にフィルムリールアイコンと、「ビデオのプロ

パティ (Video Properties)」ダイアログで指定したビデオの 

1 フレームめのタイムコードが表示されます。 

ビデオが添付されると同時にビデオウィンドウも開きます。ウィンドウははじめ真っ黒

な状態となる場合もありますが、再生が始まり次第ビデオが表示されます。 

添付ビデオファイルの配置: 添付したビデオファイルは Dorico プロジェクト内に埋め

込まれるわけではありません。プロジェクトを第三者に送信する場合、送信先でビデ

オへのアクセスが必要なときは、ビデオファイルを個別に送信する必要があります。 

 

ビデオが添付されたプロジェクトを開いてもビデオを配置でき

ない場合は、フローパネルのフローのカードに、フィルムリー

ルアイコンのかわりに三角形の警告アイコンが表示されま

す。 

プロジェクトにビデオを復元させるには、右クリックして「ビデオ (Video)」▸「添付 

(Attach)」を選択し、同じビデオファイルを添付しなおします。ビデオの既存のプロパ

ティは維持されます。 
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ビデオを添付せずに作業する: マーカー、タイムコード、テンポ検出など、画像に合わ

せて楽曲を構成するための Dorico の機能はすべて、ビデオが添付されていない状

態でも使用できます。ビデオを添付していなくても、フレームレートとタイムコード開始

の値は、「ビデオのプロパティ (Video Properties)」ダイアログを使用して指定できま

す。ダイアログを開くには、フローのカードを右クリックして「ビデオ (Video)」▸「プロパ

ティ (Properties)」を選択します。 

ビデオウィンドウ: 「ウィンドウ (Window)」▸「ビデオ (Video)」を選択するか、キーボ

ードショートカット [F4] (デフォルト) を使用すると、ビデオウィンドウの表示/非表示を

切り替えられます。ウィンドウのサイズと位置は、プロジェクトごとではなく、アプリケー

ションの環境設定において保存されます。 

フレームレートとタイムコード: Dorico は、24fps から 60fps まで、ドロップフレーム

のタイムコードも含めて、映画やテレビのプロフェッショナルな制作現場で使用される

フレームレートを幅広くサポートします。米国およびカナダの放送で使用される 

NTSC 方式はフレームレートが 29.97fps であるため、ドロップフレームのタイムコ

ードを使用する必要があります。ノンドロップフレームのタイムコードの場合、各フレー

ムは単純に前のフレームから順番に番号付けされますが、ドロップフレームのタイム

コードの場合は、29.97fps と 30fps の間にある差異 0.03fps を埋め合わせるため

に、周期的にタイムコード番号のスキップが行なわれます。毎 10 分を除いた毎分、

タイムコード番号が 2 つフレームカウントから省かれます。59.94fps と 60fps の間

にある 0.06fps の差異についても、同様の原理が適用されます。 

Dorico では、ノンドロップフレームのタイムコードは末尾に「fps」が付き、ドロップフレ

ームのタイムコードは末尾に「dfps」が付きます。 

タイムコードは「hh:mm:ss:ff」の形式で表示されます。それぞれ 2 桁で時間、分、秒、

フレームを表わします。ドロップフレームのタイムコードは、秒とフレームの間に区切り

文字としてコロンではなくセミコロンを使用します。つまり、ノンドロップフレームのタイ

ムコードは「00:00:01:05」と表示され、ドロップフレームのタイムコードは

「00:00:01;05」と表示されます。 

トランスポートウィンドウ (キーボードショートカット [F2]) には、通常の経過時間にか

わってタイムコードを表示することもできます。これを有効にするには、再生オプション

の「タイムコード (Timecode)」ページで、「タイムディスプレイ (Time display)」を「タ

イムコード (Timecode)」に設定します。 

ビデオの音声トラック: 添付ビデオの音声トラックは、スコアの再生と同期して再生さ

れます。ビデオの音声トラックの相対的な音量を調節するには、ミキサーを開いて 

(キーボードショートカット [F3])、ツールバーの「ビデオ (Video)」フィルターボタンをク

リックしてビデオフェーダーを表示します。「ビデオ (video)」フェーダーは、フェーダー

の並びの右側、「Reverb」フェーダーと「Output」フェーダーの直前に表示されます。

ビデオフェーダーをミュートすると、ビデオの音声トラックをミュートできます。 
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流れに沿ってビデオを確認する: ビデオウィンドウには、常に再生ヘッドの現在位置

に対応するフレームの画像が表示されます。Dorico が再生を停止しているときに再

生ヘッドの位置を示す緑のラインが表示されない場合は、「環境設定 (Preferences)」

の「全般 (General)」ページの「再生 (Play)」セクションにある「停止時に再生ヘッド

を表示 (Show playhead when stopped)」チェックボックスをオンにします。 

再生ヘッドは、トランスポートウィンドウの早送り (fast-forward) / 巻き戻し (rewind) 

ボタンをクリックするか、キーボードにテンキーがある場合は、[+] と [-] キーを使用

して動かすことができます。キーボードにテンキーがない場合は、[F7] で巻き戻し、

[F9] で早送りを実行できます。Windows の場合は [Ctrl]、Mac の場合は 

[Command] を同時に押すことで、1 秒ではなく 1 フレーム単位で移動できます。

Mac では、ファンクションキーの列はデフォルトで、ボリューム、画面の明るさ、メディ

ア再生などの制御のためにシステムが使用するため、[Fn] キーも併せて同時に押さ

なければならない場合があります。 

マーカー: マーカーとは、ビデオの特定のタイムコードに紐づけられたラベルで、多く

の場合は音楽的に目立たせるべき重要な瞬間を示します。マーカーは、「記譜 

(Write)」▸「マーカーを作成 (Create Marker)」を選択するか、キーボードショートカッ

ト [Shift]+[Alt]+[M] (デフォルト) を使用することで、再生ヘッドの現在位置に追加で

きます。マーカーはスコアの対応する位置に表示され、マーカーのラベル (デフォルト

では「マーカー (Marker)」と表示される) は、プロパティパネルの「マーカー 

(Markers)」グループにある「マーカーテキスト (Marker text)」プロパティか、または

記譜モードのマーカーパネルのいずれかを使用して編集できます。 

マーカーパネル: マーカーは、記譜モードのマーカーパネル

で、現在のフローのマーカーをリスト表示する表の下部にあ

る「+」ボタンをクリックすることで、パネルに直接追加するこ

ともできます。これは、たとえばすでにマーカーの候補位置

を調査済みで、それぞれのマーカー位置のタイムコードが

わかっている場合などに便利です。各マーカーのタイムコー

ドとテキストはどちらも、マーカーパネルの表内の編集する

フィールドをダブルクリックして直接インラインで編集できま

す。 

マーカーパネルの表の 3 列めには「Imp.」というラベル

が付いています。これは「Important」 (重要) の略で

す。 

重要なマーカーとは、音楽的な表現に注意を向けさせることが極めて重要であること

を示すマーカーであり、Dorico のテンポ検索機能において重要な役割を果たします。

マーカーを重要なマーカーとして設定するには、単に「Imp.」列のチェックボックスをオ

ンにします。 
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マーカーのデザイン: マーカーのデザインに関するオプションは、浄書オプションに新

しくできた「マーカー (Markers)」ページにあり、ここではタイムコードとラベルのどちら

を上に配置するかを決定したり、線の太さと余白を調節したりできます。フォントファミ

リー、ウェイトまたはポイントによるサイズを変更するには、「浄書 (Engrave)」▸「フォ

ントスタイル (Font Styles)」の「マーカーテキスト用フォント (Marker text font)」ま

たは「マーカーのタイムコード用フォント (Marker timecode font)」を編集します。 

マーカーの表示位置を選択: デフォルトでは、マーカーはフルスコアレイアウトでは 1 

番上の譜表の上に表示され、パートレイアウトでは表示されません。マーカーの表示

位置を変更するには、「垂直位置 (Vertical position)」を「組段の上 (Above 

system)」または「組段の下 (Below system)」のいずれかに設定します。または、タ

イムコード専用の譜表にマーカーを表示することも選択できます。 

スコアにタイムコードを表示する: Dorico は、スコアにタイムコード用の特別な譜表を

作成して、そこにタイムコードを表示できます。タイムコードの譜表を表示するには、レ

イアウトオプションの「マーカー (Markers)」ページを選択して、「垂直位置 (Vertical  

position)」を「タイムコードの譜表 (Timecode staff)」に設定したうえで、「タイムコ

ードの譜表を大括弧の上に配置 (Position timecode staff above bracket)」に、

その上にタイムコードの譜表を表示させるインストゥルメントファミリーを設定します。

最後に、「タイムコード譜表におけるタイムコードの頻度 (Timecode frequency on 

timecode staff)」を設定して、タイムコードの表示を 1 小節ごと、組段ごと、または

非表示 (タイムコードの譜表にマーカーだけを表示する場合) から選択できます。 

記譜モードでマーカーをドラッグする: マーカーには固定されたタイムコードの位置が

設定され、添付されたビデオの特定のフレームに効果的に紐づけられます。楽譜上

に表示されるマーカーの位置を変更するには、記譜モードでマーカーを左または右に

ドラッグします。これによって、フローの開始位置からマーカー位置までのすべてのテ

ンポ変更は取り消され、フローの開始位置には、マーカーの位置に適合する新規の

テンポが設定されます (マーカーを右にドラッグするとテンポが上がり、左にドラッグ

するとテンポが下がります)。このツールはシンプルな機能しか持たず、たとえばマー

カーを 1 つドラッグしたとき、それより前にあるマーカーの位置は固定したままで、テ

ンポへの影響は 1 つ前のマーカー以降に留まるというような機能は、今のところ実現

できていません。このように高度な編集作業については、再生モードでタイムトラック

の編集を行ないます。 

 

再生モードでタイムトラックを編集する: 再生モードのタイムトラックが一新され、フロ

ーのテンポ変更に対する精密な制御をグラフィカルに行なえるようになりました。ビ

デオが添付されると、マーカーと添付されたビデオのためのトラックが、再生モードの

イベントディスプレイの最上段にも表示されます。タイムトラックの中のテンポを編集

すると、マーカーの位置がリアルタイムに更新されます。主要なポイントにテンポ変

更を挿入することで、各マーカーの楽譜との相対位置の調整が容易に行なえます。 
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テンポを検索: Dorico の新機能である「テンポを検索 (Find Tempo)」ウィンドウを

使用して、フロー全体の適切なテンポを特定できます。このウィンドウは、記譜モード

のマーカーパネルにある「テンポを検索 (Find Tempo)」ボタンをクリックすると開き

ます。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

「テンポを検索 (Find Tempo)」ウィンドウを使用するには、マーカーパネルで少なく

とも 1 つのマーカーが重要 (Imp.) に指定されている必要があります。このウィンド

ウでは、フロー中の重要なマーカーに対し、たとえば拍にできるだけ近い位置に来る

ようにする場合などに、最適なテンポを検出できます。 

左側のコントロールから任意の拍の単位を選択してから、右側の「テンポ範囲  

(Tempo range)」スライダーを使用して、検出対象とするテンポの下限と上限を選択

します。拍の単位とテンポ範囲を調節すると、左側の「検出されたテンポ (Tempos  

found)」のリストが更新されます。検出されたテンポは、重要なマーカーの平均「フレ

ームオフ」、つまりそれぞれのマーカーが拍からはずれたフレーム数の平均に従い、

降順でリスト表示されます。 

IFO、NFO および AFO の略語はそれぞれ重要なマーカー (IFO)、重要ではないマ

ーカー (NFO)、そしてすべてのマーカー (AFO) の平均フレーム数を意味します。 

右側の「マーカー (Markers)」リストでは、「検出されたテンポ (Tempos found)」リ

ストで選択したテンポのより詳細な情報が得られます。リストには各マーカーが表示さ

れ、続いて、選択したテンポを使用した場合の拍からはずれたフレームの数 (Fr. 

Off)、小数点以下の秒数で表わされるマーカー位置と拍との時間差 (Time Diff.)、

および全音符との比率によるデュレーションで表わされるマーカー位置と拍との差 

(Not. Diff.) が表示されます。 

最適なテンポが決まったら、「検出されたテンポ (Tempos found)」リストからそのテ
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ンポを選択して、リスト下の「適用 (Apply)」ボタンをクリックします。これによりフロー

の開始位置に選択したテンポが追加され、他のテンポ指示はすべてフローから消去

されます。 

 

拍子記号 
 

Dorico 2 では、拍子記号の表示に関する新機能として、配置に関する 2 つのオプ

ションとデザインに関する 3 つのオプションが新たに導入されています。各譜表に 1 

つずつ表示する通常の配置のほかに、複数の譜表の上、つまりテンポやリハーサル

マークなどの組段アイテムと同様の位置に 1 つの拍子記号を表示したり、大括弧ご

とにセンタリングされた大きな拍子記号 1 つを表示したりできるようになりました。こ

れらのオプションはいずれも、頻繁に拍が変更される楽譜において拍子記号を目立

たせる働きがあります。 

拍子記号の配置を選択する: 拍子記号の配置に関する新オプションのいずれかを選

択するには、レイアウトオプションに新設された「拍子記号 (Time Signatures)」ペー

ジを開きます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

オプションを設定する際は、レイアウトの種類に対し適切な配置タイプを選択します。

通常、「大括弧ごとに 1 つ表示 (Show once per bracket)」や「組段オブジェクトの

位置に表示 (Show at system object positions)」はスコアレイアウトのみに使用

します。例外として、レコーディングスタジオで使用するためのパートレイアウトでは、

通常より大きな拍子記号を使用するために「大括弧ごとに 1 つ表示 (Show once 

per bracket)」を選択する場合もあります。 
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大括弧ごとに 1 つ表示する拍子記号: 大括弧ごとに表示される大きな拍子記号は、

通常の拍子記号より大幅に大きくなることから、水平方向に占めるスペースも大幅に

大きくなります。このため、拍子記号のデザインに関するオプションの変更も併せて行

なうことをおすすめします。これもレイアウトオプションに新設された「拍子記号 (Time  

Signatures)」ページから選択できます。 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

「ナローセリフ (Narrow, serif)」オプションでは、伝統的な拍子記号の数字のナロー

フォント版を使用します。このフォントは、Britten、Birtwistle など 20 世紀中頃の作

曲者による作品の編纂物に使用されたものに似た外観を有します。「ナローサンセリ

フ (Narrow, sans serif)」オプションでは、Helvetica などのグロテスクフォントに相

当する外観を有するサンセリフフォントの数字を使用します。このフォントは、映画、テ

レビおよびゲーム音楽のレコーディング用に作成された楽譜に使用されるものに外観

が似ています。上記のかわりに、「プレーンフォント (Plain font)」オプションも選択で

きます。これは「拍子記号用プレーンフォント (Time signature plain font)」 (「浄書 

(Engrave)」▸「フォントスタイル (Font Styles)」で編集可能) で定義したフォントを使

用しますが、これにはナローまたはコンデンスドスタイルのフォントを選択することをお

すすめします。 

アンサンブル中の大括弧にはそれぞれ拍子記号が 1 つずつ表示され、デフォルトで

は大括弧の垂直方向に中央揃えされています。単体で大括弧を持たない譜表には拍

子記号が表示されますが、デフォルトでは通常の拍子記号よりも大きくなります。中括

弧でつながれた譜表のペアも同様に、それぞれの譜表に通常より大きい拍子記号が

表示されます。大括弧ごとに 1 つの拍子記号を表示させる際に、無音程打楽器、有

音程打楽器および鍵盤楽器の大括弧も 1 つの拍子記号を共有する 1 つのグルー

プとして扱うようにする場合は、浄書オプションを開いて「拍子記号 (Time 

Signatures)」ページに移動し、「打楽器およびキーボード用の大括弧 (Brackets 

for percussion and keyboards)」を「単一の大括弧として扱う (Treat as single 

bracket)」に設定します。 
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映画、テレビおよびゲーム音楽のレコーディング用のスコア作成においては、拍子記

号は大括弧の中心ではなく上端に揃えられる場合があります。これを再現するには、

浄書オプションを開いて「拍子記号 (Time Signatures)」ページに移動し、「大括弧

に対する垂直方向の整列 (Vertical alignment relative to bracket)」を「上揃え 

(Top)」に設定します。 

浄書オプションの「拍子記号 (Time Signatures)」ページでは、大括弧に含まれる譜

表の数ごとに、拍子記号の表示倍率を指定できます。これは、デフォルトのオプション

「すべての譜表に表示 (Show on every staff)」使用時の通常の表示記号に対する

相対値となります。譜表が 1 つの場合 (1 1/4 または 125%)、譜表が 2 つか 3 

つの場合 (4 または 400%)、および譜表が 4 つ以上の場合 (10 または 1000%) 

で、それぞれ個別に倍率が設定されています。 

組段オブジェクトの位置の拍子記号: 1 番上の譜表 (およびオプションとしてその他

の譜表) の上の、テンポやリハーサルマークなどの組段アイテムの位置に表示され

る拍子記号は、水平方向、つまりリズムのスペースを占領しない利点がありますが、

垂直方向のスペースの消費が大きくなります。この種の拍子記号の配置は Carter 

や Henze などの作曲家による作品の編纂物で使用されることにより、20 世紀を通

してアート音楽の分野で急速に普及しました。 

拍子記号が上に表示される譜表は、リハーサルマーク、テンポ、リピート括弧などが

上に表示される譜表と同じであり、これはレイアウトオプションの「譜表と組段 

(Staves and Systems)」ページの「組段オブジェクト (System Objects)」セクション

にあるオプションを使用して設定できます。 

譜表の上の拍子記号は、デフォルトでは通常の拍子記号の 2 倍のサイズで表示さ

れますが、これは浄書オプションの「拍子記号 (Time Signatures)」ページにある

「組段オブジェクトの位置に表示される拍子記号の倍率 (Scale factor for time 

signatures shown at system object positions)」で変更できます。 

譜表の上の拍子記号はリズムのスペースを占拠しないため、幅の狭い拍子記号のデ

ザインを使用することはそれほど必要ではありません。しかし拍子記号がリハーサル

マークやテンポ指示とぶつかる場合、デフォルトでは拍子記号が他のアイテムを右に

押しやります。そのため、幅の狭いデザインを使用すればそれらの位置ずれを小さく

できるため、一考する余地があります。テンポやリハーサルマークを拍子記号の上に

表示させる場合は、浄書オプションの「拍子記号 (Time Signatures)」ページにある

「テンポおよびリハーサルマークに対する拍子記号の位置 (Position of time 

signatures relative to coincident tempo and rehearsal marks)」を「下に配置 

(Position below)」に変更します。 
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譜表の上の拍子記号が小節番号とぶつかる場合は、レイアウトオプションの「小節番

号 (Bar Numbers)」ページにある「組段オブジェクト位置に拍子記号がある場所で

は小節番号を非表示 (Hide bar numbers at time signatures at system object  

positions)」をオンにして小節番号を非表示にできます。 

譜表の上の拍子記号は、小節線の上に中央揃えとするか、左揃えとするかを選択で

きます。組段の終了位置で拍の変更を通知する拍子記号は、組段の終了位置で右

揃えされます。ただしそこに調号の変更もあり、それが十分な幅を占めている場合は、

上記の選択した配置が使用されます。配置の選択は、浄書オプションの「拍子記号 

(Time Signatures)」ページにある「小節線に対する整列 (Alignment relative to  

barlines)」オプションで行ないます。 

拍子記号の分母が音価で表示される場合、分母は、分子の下ではなく右に、符尾が

上向きの音符を使用して表示されます。分母の音符の表示倍率は、浄書オプション

の「拍子記号 (Time Signatures)」ページにある「音符のデュレーションとして表示さ

れる分母の倍率 (Scale factor for denominator when shown as note 

duration)」を変更することで、分子の表示倍率とは個別に調節できます。 

それぞれの拍子記号は、浄書モードで [Alt]+矢印キーまたはマウスドラッグを使用し

て、個別に微調整できます。「編集 (Edit)」▸「ポジションをリセット (Reset Position)」

を使用すると、オフセットの取り消しができます。 

 
システムトラック 

システムトラックは、組段内のすべての譜表において、小節の追加と削除および音符

の選択を容易にする、ユーザーインターフェースの新要素です。 
 

 
 
 
 
 
 
 
 
 
 
 

システムトラックは、デフォルトでは新規プロジェクトで表示され、この表示/非表示は

「ビュー (View)」▸「システムトラック (System Track)」を選択して切り替えられます。

表示の場合、システムトラックは組段の 1 番上の譜表の上に表示され、通常は半透

明ですが、トラックの上にマウスポインターを移動させると不透明になります。システ

ムトラックが表示されるのは記譜モードだけです。 

デフォルトでシステムトラックが表示されないようにする場合は、「環境設定 

(Preferences)」の「全般 (General)」ページの「ビュー (View)」セクションにある「新

規プロジェクトにシステムトラックを表示 (Show system track in new projects)」を

切り替えてオフにします。 
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システムトラックをクリックすると、システムトラックが選択状態になります。[Shift] を

押しながら他の小節の上にあるシステムトラックをクリックすると、選択範囲を広げる

ことができます。システムトラックが選択されると、システムトラックの中および上に追

加のボタンが表示されます。選択範囲の左側には削除ボタン、右側にはシステムトラ

ックの選択範囲で指定されるすべてのインストゥルメントの音符を選択するボタンがあ

り、また、システムトラックで選択した小節のうち最後の小節とその次の小節の間に小

節を挿入するボタンがあります。 

システムトラックの表示中に [Alt] を押すと、システムトラックにリズムグリッドの現在

値に応じたグリッドラインが表示され、[Alt] を押しながらシステムトラックをクリックし

てドラッグすると、小節内の一部を選択できます。選択を行なうと、小節単位の選択と

同様に、選択範囲の両端にそれぞれ削除と音符選択のボタンが表示されます。 

システムトラックの選択は一時的なものです。小節の挿入や、システムトラックの選択

範囲の全インストゥルメントのすべての音符の選択といった、1 つのアクションを実行

すると、選択は解除されます。システムトラックの選択は、他の選択を行なったりレイ

アウトを切り替えたりすると即座に解除されますが、ページビューとギャレービューの

切り替えにおいては選択状態が維持されます。 

 
オートメーション 

 

Dorico 2 は、テンポおよび MIDI コンティニュアスコントローラーの精密制御を行な

うための新しいツールを搭載しています。これにより再生モードの機能が拡張され、こ

の領域における将来の発展に道筋を示すものとなります。 
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タイムトラック: 再生モードのイベントディスプレイの最上段に表示されるタイムトラック

では、プロジェクトのテンポを編集できます。テンポのグラフィカルな表示においては、

固定テンポ変更は段状の変化として、徐々にテンポ変更を行なう場合は 2 点間の

線の傾きとして表示されます。任意のハンドルをクリックしてドラッグすると、そのポイ

ントのテンポを調節できます。マウスポインターの隣には小さくテンポの読み出し値が

表示され、そのポイントのテンポの視覚的なフィードバックが得られます。 

タイムトラックではテンポ変更の新規作成もできます。鉛筆ツールでトラックをクリック

して、新規のテンポ変更を書き込みます。マウスボタンを押さえたまま横に移動させる

と、複数のテンポ変更を一度に書き込めます。テンポ変更が作成される頻度は、リズ

ムグリッドの設定により決定されます。リズムグリッドの値が小さいほど、マウスをトラ

ックに沿って横に移動させたときに作成されるテンポ変更の数が多くなります。 

よりなめらかで直線的な段階的変化を作成するには、ラインツールを使用します。変

化を開始するポイントをクリックしてから、段階的変化の終了位置までドラッグします。 

再生モードにおいて鉛筆ツールまたはラインツールで挿入されたテンポ変更は、スコ

ア印刷時の外観が変わることを避けるため、デフォルトで記譜モードではガイドとして

表示されます。これらのテンポを印刷に反映させる場合、記譜モードで選択のうえ、プ

ロパティパネルの「テンポ (Tempo)」グループにある「テキスト (Text)」プロパティを

設定して表示させます。 

再生モードでテンポ変更を削除するには、削除ツールを使用します。タイムトラック内

のポイントを 1 つずつクリックするだけで、そのテンポ変更が削除されます。 

MIDI コントローラートラック: それぞれのインストゥルメントに、MIDI コントローラー

データを編集するためのレーンを表示できるようになりました。今のところ表示できる

レーンは 1 つだけですが、これで複数の MIDI コントローラーのデータを作成でき

ます。 

MIDI コントローラーレーンを表示するには、オートメーションデータを作成するインス

トゥルメントのトラックヘッダーに新たに設置されたボタンをクリックします。  

インストゥルメントのすぐ下に、そのインストゥルメントに属するレーンが表示されます。

コントローラーレーンのトラックヘッダーのメニューから、データを作成する MIDI コン

トローラーを選択します。リストには 127 種の MIDI コンティニュアスコントローラー

すべてが含まれています。データがすでに入力されているコントローラーは、メニュー

内にアスタリスク (*) で印が付けられます。 

MIDI コントローラーのオートメーションデータの作成には、タイムトラックのテンポ変

更を作成するのと同じツールが使用されます。鉛筆ツールは個々のポイントを作成し

ます。クリックするか一定の範囲をドラッグすることで、リズムグリッドの分割ごとに個

別のポイントを書き込めます。ラインツールは 2 つの値の間になめらかで直線的に

移行する線を作成します。削除ツールは既存のポイントをクリックして消去します。  
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MIDI の書き出し: MIDI ファイルを書き出すとき、タイムトラックおよび MIDI コントロ

ーラートラックに書き込まれたオートメーションイベントはすべてファイルに含まれま

す。 

 
ディヴィジ 

 

ディヴィジとは、「分割する」という意味のイタリア語から来ており、オーケストラの弦楽

器の譜面では一般的な技法です。バイオリンでの使用が特に多いですが、専用という

わけではありません。弦楽器セクション以外の楽器、たとえば合唱などで使用される

こともあります。1 つのセクションを複数の小さなセクションに分けて、それぞれの譜

表に記譜することにより、より豊かな響きや音色、または対位法による表現が可能と

なります。 

 
 
 
 
 
 
 
 

ディヴィジのパッセージの作成は、従来の楽譜作成ソフトウェアが極めて不得手とす

る作業でしたが、Dorico 2 独自のディヴィジのための新機能により、これは改善され

ました。 

流れを簡単に説明すると、分割を行なうインストゥルメントにディヴィジを作成し、使用

する譜表の数と、それぞれの譜表に付与するラベルを指定します。ここからは、 

Dorico が自動でこれらの譜表を管理します。組段やフレーム区切りにおいて発生す

るディヴィジセクションの変化について操作を行なう必要はありません。ディヴィジが

組段の途中で開始または終了する場合、Dorico は必要に応じて各ディヴィジの譜表

にユニゾンの音符を自動的に表示させます。ディヴィジセクションが終了したら、トゥッ

ティへの復元の指示を作成します。再び Dorico が完全自動で追加譜表の削除を行

ないます。 
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ディヴィジを作成する: ディヴィジは、セクションプレーヤーが演奏するインストゥルメ

ントにおいてのみ作成できます。ソロプレーヤーは 1 人の演奏者を意味するため、こ

のインストゥルメントを分割することはできません。一方、セクションプレーヤーは全員

が同じ楽器を演奏する複数の人間を意味するため、分割することができます。新規の

ディヴィジを作成するには、ディヴィジの開始ポイントを選択して、「編集 (Edit)」▸「譜

表 (Staff)」▸ 「ディヴィジを変更 (Change Divisi)」を選択します。以下のダイアログ

が表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ダイアログ上部のリストには、今あるディヴィジョンが表示されます。新規にディヴィジ

を作成するときには、「Tutti」というラベルのディヴィジョンが 1 つだけ存在します。

ディヴィジョンのリストの下にあるアクションバーから、ソリストおよびセクションの 2 

タイプのディヴィジョンを新規に作成できます。ソリストを追加するには「ソロのディヴィ

ジョンを追加 (Add Solo Division)」ボタン (   ) を、セクションを追加するには「セ

クションのディヴィジョンを追加 (Add Section Division)」ボタン (   ) をクリックし

ます。追加したソリストまたはセクションはそれぞれスコアに追加された譜表に対応し

ます。作成できるソリストおよびセクションの数に制限はありません。機能をできるだ

けシンプルかつ柔軟に保つために、Dorico はフロー中のプレーヤーの総数を数えま

せん。作成者がそれを把握していることを前提としています。 

ディヴィジョンに表示されているラベルを変更するには、ダイアログ上部のリストから

ディヴィジョンを選択し、下の「譜表ラベル (Staff labels)」セクションのテキストを編

集します。セクションラベルは、各組段の開始位置、セクションの譜表のすぐ左側に表

示され、通常は単に番号か、場合によってはアルファベットを使用して、どのデスクま

たはプレーヤーがその楽譜を演奏するのかを示します。 
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ダイアログ上部のディヴィジョンのリストから隣接する複数のディヴィジョンを選択して

「グループを追加 (Add Group)」ボタン (   ) をクリックすると、セクションをさらにグ

ループにまとめることもできます。グループラベルは、グループ化されたディヴィジョン

に属するすべての譜表に対する中央揃えで、インストゥルメント名の位置に表示され

ます。グループラベルを編集する際は、エディターのすぐ上に表示されるボタンを使用

して、「正式名称 (Full Name)」と「略称 (Short Name)」を個別に編集できます。 

最後に、「ディヴィジを変更 (Change Divisi)」ダイアログの下部にある「プレーヤー

名またはグループ名を表示 (Show player or group name)」および「セクション番

号を表示 (Show section numbers)」のオプションを使用して、このディヴィジで定

義されるラベルに対し、レイアウトオプションの「譜表と組段 (Staves and Systems)」

ページの設定に従う (「オプションに従う (Follow Options)」) か、常に表示させる 

(「表示 (Show)」) または常に非表示にする (「非表示 (Hide)」) のいずれかでオプ

ションの設定を上書きするかを指定できます。 

すべての設定が終わった後「OK」をクリックすると、ディヴィジの変更が作成され、ガ

イドが表示されます。これは記譜モードにおいてマウスドラッグまたは [Alt]+[←]/[→] 

により、ディヴィジの変更を実行する位置を変更できます。ディヴィジの変更で定義さ

れたソリストおよびセクションで指定された追加の譜表は、対応するラベルが組段の

左側に付与され、組段の開始位置から表示されます。ディヴィジの変更より前にユニ

ゾンの小節または小節の一部がある場合、新しくできたすべてのディヴィジの譜表に

は、ディヴィジの変更がある位置までユニゾンの音符が自動的に表示されます。あと

は新しいディヴィジ譜表に、通常の譜表と同様に音符を入力するだけです。 

既存のディヴィジの変更を編集する: 既存のディヴィジの変更を編集するには、ディ

ヴィジのガイドをダブルクリックします。「ディヴィジを変更 (Change Divisi)」ダイアロ

グが開いて変更を行なえるようになります。ディヴィジセクションを削除する場合、削

除する前にこの譜表に記されていた音符は削除されず、再生時に演奏されるので注

意してください。セクションを削除する前には、削除対象となるディヴィジの譜表からす

べての音符を削除することをおすすめします。逆に、以前あったディヴィジセクション

を後から再作成した場合、すべての音符が復元されます。 

ディヴィジョンを変更する: ディヴィジのパッセージをさらに分割する場合、またはディ

ヴィジョンの一部のみを終わりとする場合、上記と同様の手順で、対応する場所にさ

らなるディヴィジの変更を作成できます。組段に表示される譜表は、その組段で最初

のディヴィジの変更で定義されたものだけが表示されます。同じ組段でさらなるディヴ

ィジの変更を作成する場合、その効果は次の組段の開始位置から現れます。 

ディヴィジのパッセージを終了する: ディヴィジのパッセージを終了するときは、メイン

譜表上で終了位置の音符または休符を選択し、「編集 (Edit)」▸「譜表 (Staff)」▸「トゥ

ッティを復元 (Restore Tutti)」を選択します。これにより、ダイアログを表示すること

なく、トゥッティのセクション 1 つだけからなるデフォルトのディヴィジの変更が作成さ
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れます。この変更が組段の終了位置より前にある場合、ディヴィジの変更と組段の終

了位置の間にある小節または小節の一部に、自動的にユニゾンの音符が表示されま

す。 

ユニゾンのパッセージ: ディヴィジの譜表でユニゾンの音符を選択すると、メインの譜

表、さらには他のすべてのディヴィジの譜表にある同じ音符が選択状態になります。

この音符を個別に編集することはできず、ディヴィジの譜表に加えた変更は他のすべ

ての譜表の同じ音符に反映されます。 

ユニゾンのパッセージを判別しやすくするには、「ビュー (View)」▸「音符と休符のカラ

ー (Note and Rest Colors)」▸「ディヴィジユニゾン範囲 (Divisi Unison Ranges)」

で色を切り替えられます。ユニゾンのパッセージに属する音符や休符を薄いグレーで

表示し、実際のディヴィジのマテリアルと区別しやすくします。 

同じソースの音符を複数の譜表に表示するのは複雑な処理であるため、Dorico が

ディヴィジの譜表にユニゾンの音符を自動表示させる際に扱えるマテリアルの種類に

は少しばかり制限があります。これはディヴィジのパッセージが開始する前となる組

段の開始位置、またはディヴィジのパッセージが終了した後となる組段の終了位置、

いずれにおいても同様です。まず挙げられる制限はスラーに関するものです。ディヴ

ィジのパッセージ開始位置前後にわたるスラーは、ディヴィジの譜表には表示されま

せん。これに対処するには、ディヴィジのパッセージの開始位置をスラーの開始位置

まで移動させ、その音符をディヴィジの譜表に手動でコピーアンドペーストします。同

様の問題が歌詞にも存在します。また、オクターブ線はメインの譜表にしか適用され

ませんが、段階的強弱記号 (ヘアピンなど) は正常に処理されます。 

ディヴィジの譜表からユニゾンのマテリアルの演奏に戻るポイントにおいて、メインの

譜表とは異なる音部記号が使用されている場合、Dorico は適切な音部記号をその

譜表に自動作成しますが、その際、その直後の音符とのスペーシングが近すぎること

があります。可能であれば、メインの譜表と同じ音部記号に復元できるように、ディヴ

ィジのパッセージの終了位置より前のどこかに適切な音部の変更を挿入してくださ

い。 

ディヴィジと譜表ラベル: レイアウトオプションの「譜表と組段 (Staves and 

Systems)」ページにある「譜表ラベル (Staff Labels)」セクションには、以下の 2 つ

の新たなオプションが追加されています。 

 グループ名を表示 (Show group names)」は、現在のレイアウトで譜表ラベルの

正式名称と略称のいずれかまたは両方が表示される設定になっている場合のみ

有効となります。これがオンのときは、インストゥルメント名にかわってディヴィジの

グループラベルが表示されます。 

 セクション名を表示 (Show section names)」は、ディヴィジのグループ名やイン

ストゥルメント名が表示されているかどうかに関わらず設定できます。この設定の

典型的な使用例としては、パートレイアウトでは、ディヴィジのセクション名の表示
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は必要でも、通常の譜表ラベルは必要ない場合があります。そこにある譜表はす

べて (たとえば) Violin I が演奏することが明らかであり、譜表ラベルを表示しても

有用な情報が何も追加されない場合などにこの設定を使用します。 

このオプションの設定は、「ディヴィジを変更 (Change Divisi)」ダイアログの「プレー

ヤー名またはグループ名を表示 (Show player or group name)」および「セクショ

ン番号を表示 (Show section numbers)」オプションにより、ディヴィジの変更ごと

の設定に上書きされます。 

ディヴィジの再生: 本リリースでは、ディヴィジのマテリアルはすべて、ソリストのマテ

リアルも含めて、1 つのチャンネルで再生されるため、異なるセクション間に許容され

る差異は限定されています。Dorico の今後のリリースでは、ディヴィジのパッセージ

内の各ソリストおよびセクションを個別のチャンネルに割り当てて、ディヴィジのパッセ

ージの再生において優れた柔軟性を発揮できるようにする予定です。 

ボーカル譜表におけるディヴィジ: ボーカルのセクションプレーヤーにディヴィジを使

用する場合、Dorico はディヴィジのパッセージが開始される直前の組段の終了位置

に、パート分割の矢印を自動的に表示します。 

 
 
 
 
 
 
 
 
 
 
 

またディヴィジのパッセージが終わる組段の終了位置では、ディヴィジの譜表それぞ

れに矢印が表示され、戻り先の 1 つの譜表にシンガーを誘導します。 

この動作を管理するには、浄書オプションの「ディヴィジ (Divisi)」ページにある「声楽

譜表の組段終端にあるディヴィジの指示 (Indicate divisi at end of system on 

vocal staves)」オプションを変更します。  
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オッシア 
 

オッシアは、本来のパッセージのかわりに演奏してもよい代替パッセージを示します。

これは、装飾音を実際に演奏する際の編者が推奨する形や、異なる出典間の差異、

あるいはより演奏が容易なバージョンを表示するような場合に使用されます。Dorico 

2 は、オッシアのパッセージを処理するための包括的な機能を導入しています。 

 

 
 
 
 
 
 
 
 
 
 
 
 

オッシアを追加する: オッシアを追加するには、オッシアの譜表を表示させる範囲を

選択してから「編集 (Edit)」▸「譜表 (Staff)」▸「オッシアを上に作成 (Create Ossia 

Above)」または「オッシアを下に作成 (Create Ossia Below)」を選択します。ピアノ

やその他の大譜表を使用するインストゥルメントの楽譜を作成していて、上下いずれ

の譜表も表示するオッシアが必要である場合、右手譜表と左手譜表の両方のマテリ

アルを選択してから、「オッシアを上に作成 (Create Ossia Above)」または「オッシ

アを下に作成 (Create Ossia Below)」を選択します。 

オッシアを作成できるのは、ソロプレーヤーが演奏するインストゥルメントのみです。セ

クションプレーヤーが演奏するインストゥルメントには、ディヴィジの方法を除いては譜

表の追加は行なえません。同様に、打楽器キットのインストゥルメントにもオッシアを

追加できません。インストゥルメントには必要に応じて上下いずれの側にもオッシアを

表示できますが、譜表の同じ側には一度に 1 つのオッシアしか表示できません。 

オッシアのパッセージの開始位置、およびオッシアの譜表が消える終了位置にはガイ

ドが表示されます。これらのガイドは、記譜モードで選択してドラッグして、または  

[Alt]+[←]/[→] でナッジできます。ガイドとともにオッシアの開始位置および終了位置

も移動します。 

オッシアを削除する: オッシアのパッセージを削除するには、オッシアのパッセージの

両端にあるガイドを削除するか、またはオッシアのパッセージ内の音符または休符を

選択して、「編集 (Edit)」▸「譜表 (Staff)」▸「譜表を削除 (Remove Staff)」を選択し

ます。 

オッシアを削除する際は、最初にオッシア内の音符を削除していない限りは、音符は

単に表示されなくなるだけで存在はし続けることに注意してください。後ほど同じ位置

にオッシアを再作成すると、音符は再び表示されます。 
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倍率: デフォルトでは、オッシアの譜表は通常の譜表の 2/3 の大きさで表示されま

す。この倍率は、浄書オプションの「譜表 (Staves)」ページにある「オッシアの倍率 

(Ossia scale factor)」で調節できます。 

オッシアが表示される位置を決定する: デフォルトでは、オッシアの譜表はすべての

レイアウトに表示されますが、オッシアを特定の奏者のパートレイアウトにのみ表示す

ることや、スコアのみに表示することのほうが適切となる場合もあります。レイアウトに

オッシアを表示するかどうかを選択するには、必要に応じて、レイアウトオプションの

「譜表と組段 (Staves and Systems)」ページの「オッシアおよび追加の譜表 

(Ossias and Extra Staves)」セクションにある「オッシアを表示 (Show ossias)」を

オンまたはオフにします。 

小節線を結合: オッシアの小節線を対応するメインの譜表にどのように結合するかに

ついては、出版されている楽譜で使用されている表記規則がいくつか存在します。オ

ッシアの開始および終了いずれも小節線の位置にあると仮定して、一部の出版社は

オッシアの開始位置と終了位置の両方をメインの譜表に結合させますが、他の出版

社は終了位置のみで結合させ、さらに別の出版社はオッシアとメインの譜表をまった

く結合させません。 

オッシアをメインの譜表に結合させるとき、一部の出版社は他の譜表に使用するのと

同じ種類の小節線 (通常は縦線) を使用しますが、他の出版社はかわりに破線の小

節線でオッシアを結合させます。 

Dorico は、これらすべての表記規則に適合するためのオプションを、浄書オプション

の「小節線 (Barlines)」ページにある「オッシア (Ossias)」セクションで提供していま

す。 

オッシアがインストゥルメントのメインの譜表の間に表示される場合、たとえばピアノの

右手譜表の下に表示されるオッシアなどは、浄書オプションの「小節線 (Barlines)」

ページのオプションの選択内容にかかわらず、常にメインの譜表と同じ小節線で結合

されます。 

オッシアのラベル: オッシアの譜表の開始位置に「ossia」という単語のラベルを付与

するには、レイアウトオプションの「譜表と組段 (Staves and Systems)」ページの

「オッシアおよび追加の譜表 (Ossias and Extra Staves)」セクションにある「オッシ

アの前にラベルを表示 (Show label before ossia)」をオンにします。カスタムラベ

ルを使用する場合は、「オッシアのラベル (Ossia label)」を「カスタム (Custom)」に

設定し、「カスタムのオッシアラベル (Custom ossia label)」に任意のテキストを入

力します。 

オッシアのラベルは譜表ラベルのパラグラフスタイルに従って描写され、浄書オプショ

ンの「譜表 (Staves)」ページにある「オッシア (Ossias)」セクションに定義される距離

に従って配置されます。1 つのオッシア譜表に付くラベルと、中括弧でペアとなったオ
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ッシア譜表に付くラベルには、それぞれ個別に距離を設定できます。 

小節の途中で開始または終了するオッシア: オッシアが小節の途中で開始または終

了する場合、Dorico は記譜されたマテリアルの左右に譜表線を付け足して、音符、

臨時記号、付点その他のアイテムがオッシア譜表の終了位置に直に隣接しないよう

にします。左右に付け足す譜表線の長さを調節するには、浄書オプションの「譜表 

(Staves)」ページの「オッシア (Ossias)」セクションにある「オッシア開始位置の譜表

線の延長 (Extend staff lines at start of ossia)」および「オッシア終了位置の譜表

線の延長 (Extend staff lines at start of ossia)」を変更します。 

組段をまたぐオッシア: オッシアがある組段で開始しその次の組段で終了する場合、

通常の譜表と同様に、オッシアの音部記号と調号を組段の開始位置で再宣言したほ

うがよい場合があります。一方で、そのオッシアが追加のインストゥルメントではないこ

とを明白にするため、組段の開始位置の音部記号および調号からなる固定された譜

表冒頭部の後からオッシアが再開するのが好ましい場合もあります。 

Dorico はいずれの方法も可能とします。レイアウトオプションの「譜表と組段 

(Staves and Systems)」ページの「オッシアおよび追加の譜表 (Ossias and Extra 

Staves)」セクションにある「組段をまたぐオッシア (Ossias crossing a system 

break)」を「譜表冒頭部の記号を含める (Include in preamble)」または「譜表冒頭

部の記号を除外する (Exclude from preamble)」に設定します。 

垂直方向のスペーシング: オッシアと対応するメインの譜表とのデフォルトの距離は、

レイアウトオプションの「垂直方向のスペーシング (Vertical Spacing)」ページに新

設された「オッシア譜表から譜表まで (Ossia staff to staff)」の値によって決定され

ます。この距離は、垂直方向の両端揃えの影響を受けません。 

個別のオッシア譜表とそれが属するメインの譜表との距離は、通常どおり、浄書モー

ドで譜表のスペーシングツールを使用することで調節できます。組段では左側にハン

ドルが表示されますが、オッシアでは組段上のオッシア譜表の開始位置にハンドルが

表示されます。 

オッシアと再生: オッシア譜表の音符は再生されません。 

 
インストゥルメントの譜表の数を変更する 

Dorico 2 では、フローの任意のポイントでインストゥルメントの譜表を簡単に追加また

は削除できます。たとえば、ピアノの楽譜で 3 つまたはそれ以上の譜表を要するよう

な複雑な作品の記譜も可能になります。 

追加の譜表を作成する: インストゥルメントに追加の譜表を作成するには、追加の譜

表の開始位置で、その上か下に追加の譜表を表示させたい譜表の音符または休符

を選択して、「編集 (Edit)」▸「譜表 (Staff)」▸「上に譜表を追加 (Add Staff Above)」

または「下に譜表を追加 (Add Staff Below)」を選択します。その位置に追加の譜表

が作成され、追加 (または削除) された譜表の数を示すガイドが表示されます。 



 

Dorico 2 バージョン履歴 54ページ Steinberg Media Technologies GmbH 

 

インストゥルメントはソロプレーヤーのものでなければなりません。セクションプレーヤ

ーが演奏するインストゥルメントの譜表の数は変更できません。また、打楽器キットの

インストゥルメントにも譜表は追加できません。 

追加の譜表を削除する: 追加の譜表を削除するには、追加の譜表が表示されている

位置のガイドを選択するか、削除する位置で、削除したい譜表の音符または休符を

選択して、「編集 (Edit)」▸「譜表 (Staff)」▸「譜表を削除 (Remove Staff)」を選択し

ます。これはインストゥルメントのはじめからある譜表、たとえばピアノの右手または左

手の譜表の削除にも使用できます (ただし、インストゥルメントに属するすべての譜表

を削除することはできず、常に 1 つ以上の譜表が表示されていなければなりませ

ん)。 

追加の譜表の開始位置を選択する: 譜表が組段の途中で開始または終了するとき、

この譜表をちょうどその位置で表示または非表示にさせたい場合も、組段全体の長さ

で表示させたい場合もあります。これは、レイアウトオプションの「譜表と組段 

(Staves and Systems)」の「オッシアおよび追加の譜表 (Ossias and Extra 

Staves)」セクションに追加された「開始または停止時には組段全体に追加の譜表を

表示 (Show extra staves across full system when starting or stopping)」チェ

ックボックスで設定します。 

空白の譜表を非表示にする: インストゥルメントに作成された追加の譜表は、レイアウ

トオプションの「垂直方向のスペーシング (Vertical Spacing)」ページにある「複数の

譜表を持つインストゥルメントの個々の譜表を非表示にする (Allow individual 

staves of multi-staff instruments to be hidden)」オプションの影響を受けませ

ん。 

 
スラッシュ符頭 

 

スラッシュ符頭は、特に厳密には指定されない何かを演奏することを演奏者に指示す

るために使用されます。符尾の付かないスラッシュは一般に、何を演奏するかは演奏

者に一任されると解釈されます。符尾が付いたスラッシュは一般に、演奏するべきリ

ズムは指示されるが、音程については特に指定がないと解釈されます。前者はスラッ

シュ記譜、後者はリズミック記譜と呼ばれる場合もあります。Dorico 2 は、この 2 つ

のスラッシュ符頭について、高度なサポートを提供しています。 

スラッシュ領域: スラッシュ符頭を追加する一番簡単な方法は、スラッシュ領域を使用

することです。スラッシュ領域を使用すると、小節の範囲をスラッシュで埋めることがで

きます。有効な拍子記号に従って、スラッシュのリズムが自動的に決定されます。たと

えば、4/4 の小節では 4 分音符のスラッシュ 4 つが表示され、6/8 の場合は付点 

4 分音符のスラッシュが 2 つ表示されます。拍子記号を変更すると、領域内のスラ

ッシュのデュレーションも自動的に更新されます。 

スラッシュ領域は、1 つ以上の小節を選択してから、「記譜 (Write)」▸「スラッシュ領
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域を作成 (Create Slash Region)」を選択するか、[Shift]+[R] で新機能のポップオ

ーバーを開き、「slash」と入力し、[Return] を押してポップオーバーを確定します。

選択したデュレーションの範囲にスラッシュ領域が作成されるとともに、デフォルトで

はスラッシュの背景が緑色で強調表示され、スラッシュが領域の一部であることを示

します (これを無効にするには、「ビュー (View)」 ▸ 「スラッシュ領域を強調 

(Highlight Slash Regions)」をオフにします)。スラッシュ領域の開始位置と終了位

置にあるハンドルを使用すると、領域の両端から領域を広げたり狭めたりできます。

また、[Alt]+[←]/[→] でスラッシュ領域の開始位置の移動、[Shift]+[Alt]+[←]/[→] 

でスラッシュ領域のデュレーションの増減が行なえます。 

スラッシュ領域を分割する: たとえば領域の途中で詳細な音符を書き込むなど、スラ

ッシュ領域を 2 つに分割することが必要な場合もあります。これには、キャレットを表

示させてスラッシュ領域を分割する位置に移動させ、音符ツールボックスのはさみツ

ールをクリックするか、[U] を入力します。スラッシュ領域がキャレット位置で 2 つに

分割され、たとえば後半の領域の開始位置のハンドルを右にドラッグすると、スペー

スを確保でき任意の内容を記譜できます。 

スラッシュ領域における付点: 複合拍子記号においては、スラッシュに付点を表示す

るかどうかについて、さまざまな表記規則が存在します。Dorico は、デフォルトで複

合拍子のデュレーションのスラッシュには付点を表示します。ただし、この設定は、浄

書オプションの「音符 (Notes)」ページの「スラッシュ符頭 (Rhythmic Slashes)」セ

クションにある「複合拍子におけるスラッシュ (Slash regions in compound time 

signatures)」オプションで変更できます。 

スラッシュの外観: Dorico には、スラッシュ符頭の外観デザインが数種類用意されて

います。これは、浄書オプションの「音符 (Notes)」ページの「スラッシュ符頭  

(Rhythmic Slashes)」セクションにある「符尾ありのスラッシュ (Slashes with 

stems)」と「符尾なしのスラッシュ (Slashes without stems)」を設定することにより、

既定のデザインの中から任意の外観を選択できます。 

スラッシュ付き声部: スラッシュ領域よりも詳細なリズムの指示を書き込む場合は、ス

ラッシュ付き声部を使用します。スラッシュ付き声部による入力は、標準の声部による

入力とまったく同じです。ただし、指定した音程はすべて上書きされ、デフォルトで、入

力した音符や和音のかわりに 1 本のスラッシュが譜表の第 3 線に表示されます。

既存の声部をスラッシュ付き声部に変換、およびその逆も行なえます。元の音符や和

音のピッチは保持され、標準の声部に戻した際には復元されます。 
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スラッシュ付き声部の音符の入力を新規に開始するには、「記譜 (Write)」▸「スラッシ

ュ付き声部を作成 (Create Slash Voice)」を選択するか、[Shift]+[Alt]+[V] (デフォ

ルト) のコマンドを入力します。このコマンドは、新規に標準の声部を追加する 

[Shift]+[V] コマンドと相似になっています。 

 

 
 
 
 
 
 
 
 
 
 

[Shift]+[Alt]+[V] コマンドを繰り返し入力すると、追加されるスラッシュ付き声部のタ

イプが、符尾ありのスラッシュ (符尾を上向き)、符尾ありのスラッシュ (符尾を下向

き)、符尾なしのスラッシュの順で切り替わります。標準の声部と同様、キャラットの左

側のインジケーターにはこれから追加される声部の種類が表示されます。 

スラッシュを一度入力すると、このスラッシュ付き声部はそのインストゥルメントのどこ

にでも再使用でき、[V] で声部の切り替えを行なう際には、スラッシュ付き声部も選択

肢に含まれるようになります。 

スラッシュ付き声部のタイプを変更する: スラッシュ付き声部にリズムを伴う記譜を入

力した後に、たとえば符尾なしのスラッシュに切り替えたい場合は、スラッシュのうち 

1 つを選択して、「編集 (Edit)」▸「声部 (Voices)」▸「スラッシュ符頭 (Rhythmic 

Slashes)」から希望する声部タイプを選択します。サブメニューから「標準の音符 

(Normal Notes)」を選択すると、声部は標準の声部に変換され、音符や和音入力時

の本来のピッチが復元されます。 

スラッシュ領域においては、領域中のいずれかのスラッシュまたは開始位置か終了位

置いずれかのハンドルを選択してから、プロパティの「スラッシュ領域 (Slash 

Region)」グループにある「符尾なし (Stemless)」プロパティをオンにすることで、ス

ラッシュの符尾ありと符尾なしを切り替えられます。 

符尾の方向を変更する: 符尾ありのスラッシュにおいては、スラッシュ付き声部のデ

フォルトの符尾の方向を上向きにするか下向きにするか、標準の声部と同じ方法で指

定できます。「編集 (Edit)」▸「声部 (Voices)」▸「符尾をデフォルトで上向きにする  

(Default Stems Up)」または「符尾をデフォルトで下向きにする (Default Stems 

Down as desired)」を選択します。 

スラッシュ領域においては、領域中のいずれかのスラッシュまたは開始位置か終了位

置いずれかのハンドルを選択してから、プロパティの「スラッシュ領域 (Slash 

Region)」グループにある「声部の向き (Voice direction)」プロパティをオンにするこ

とで、符尾の方向を指定できます。  
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譜表からの位置を変更する: デフォルトでは、スラッシュ領域とスラッシュ付き声部は

いずれも譜表の第 3 線上にスラッシュを表示しています。譜表上の位置はいずれも

同じ手順で変更できます。それぞれ「スラッシュ領域 (Slash Region)」または「音符

と休符 (Notes and Rests)」グループにある「スラッシュの位置 (Slash pos.)」プロ

パティをオンにして、希望する値を設定します。「0」の値は譜表第 3 線に対応し、プ

ラスの数字は上に、マイナスの数字は下にスラッシュを移動させます。 

スラッシュ領域前後の休符: スラッシュ領域が小節の途中で開始または終了している

場合、その小節の残りの部分を休符で埋めるべきかどうかは、他の音符が譜表の同

じ位置にあるかどうかによって変わります。デフォルトでは、スラッシュ領域は前後の

両端において不完全な小節を休符で埋めようとします。ただし、プロパティの「スラッシ

ュ領域 (Slash Region)」グループにある「開始位置より前の休符を非表示 (Hide  

rests before start)」および「終了位置より後の休符を非表示 (Hide rests after 

end)」プロパティをオンにすると、休符の表示を抑制できます。 

スラッシュ付き声部を対立させる: スラッシュ付き声部が他のスラッシュ付き声部また

は標準の声部と対立する場合、Dorico は、スラッシュ付き声部のデフォルトの譜表

上の位置を上書きして、2 つの声部がなるべく衝突しないようにします。スラッシュ付

き声部のオフセットのスペースは、記譜オプションの「声部 (Voices)」ページの「スラ

ッシュ符頭の声部 (Rhythmic Slash Voices)」グループにあるオプションにより決定

されます。 

スラッシュと無音程打楽器: 打楽器キットでスラッシュを使用するには、「打楽器キット

を編集 (Edit Percussion Kit)」ダイアログを開きます (設定モードのプレーヤーパ

ネルで打楽器プレーヤーのカードを展開して、インストゥルメントのコンテキストメニュ

ーからダイアログを開きます)。5 線譜エディター下のアクションバーのスラッシュボタ

ン 2 種のうちいずれかを使用することで、打楽器キットに符尾ありまたは符尾なしの

スラッシュを追加できます。打楽器キットに 1 つ以上のスラッシュのセットを追加して、

異なる譜表上の位置に配置できます。 

音符の入力においては、矢印キーを使用してキット中の異なるインストゥルメント間を

移動する際、キットに追加したスラッシュであればすべて移動先に含まれ、打楽器キ

ットの他の音符の入力とまったく同様にスラッシュを入力できます。 

打楽器キットのスラッシュは 5 線譜の表示タイプ使用時のみ表示されます。グリッド

または個別のインストゥルメントの表示タイプに切り替えると、スラッシュは表示されま

せん。 
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小節リピート記号 

小節リピート記号は、前の 1 小節、2 小節または 4 小節に含まれる要素をまったく

同じに繰り返すことを演奏者に示します。この省略用の表記は演奏者にとって非常に

便利なものです。複数小節にわたって音符がそのまま書き出されているものは読み

づらく、本当に譜面が繰り返され相違点がないかどうかの確認が必要になりますが、

小節リピート記号を使用すると読みやすくなり、繰り返していることが明白にわかりま

す。 

 
 
 
 
 
 
 
 

小節リピート領域: 繰り返し対象となる音符を入力した後、次の小節から始まり、小節

リピート記号を表示させる範囲の終わりまでを選択して (これは後ほど変更できます)、

「記譜 (Write)」▸「小節リピート領域を作成 (Create Bar Repeat Region)」を選択し

ます。この手順により、小節リピート領域が作成されます。1 小節リピート記号が選択

範囲全体に表示されます。上記のかわりに、[Shift]+[R] で新機能のリピート記号の

ポップオーバーを開き、「%」を入力して前の 1 小節、「%2」で前の 2 小節、「%4」で

前の 4 小節のリピート記号を作成します。 

小節リピート領域を作成した後に繰り返し小節数を変更するには、小節リピート記号

のいずれか、または領域の最初または最後にある丸いハンドルを選択して、プロパテ

ィパネルの「小節リピート領域 (Bar Repeat Region)」グループにある「小節数 (No. 

bars)」プロパティの値を変更します。 

小節リピート領域は、デフォルトで背景が水色で強調表示されます。強調表示のオン/

オフを切り替えるには、「ビュー (View)」▸「小節リピート領域を強調 (Highlight Bar  

Repeat Regions)」を選択します。 

小節リピート記号をカウントする: Dorico は自動的に、小節リピート領域の上に、繰り

返した回数のカウントを一定間隔で表示します。デフォルトでは 4 小節ごとにカウン

トが表示され、音符の小節が「1」とカウントされます。たとえば 1 つの音符の小節の

後に 3 小節間の小節リピート領域が続いた場合、3 つめの小節リピート記号が「4」

とカウントされます。デフォルトのカウント間隔を変更するには、浄書オプションの「小

節リピート記号 (Bar Repeats)」ページにある「小節リピート記号の回数のカウントを 

n 小節ごとに表示 (Show bar repeat count every n bars)」を設定します。カウン

トを一切表示させない場合は、「小節リピート記号のカウントの外観 (Appearance 

of bar repeat count)」を「非表示 (Do not show)」に設定します。 

このデフォルトの設定は、個々の小節リピート領域ごとに上書きできます。プロパティ

の「小節リピート領域 (Bar Repeat Region)」グループにある「カウント頻度 (Count  

frequency)」または「カウントの外観 (Count appearance)」をオンにします。「カウ
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ント開始位置 (Count from)」プロパティをオンにすると、Dorico がカウントを開始す

る回数も指定できます。 

小節リピート記号のカウントのフォント、サイズ、スタイルを変更するには、「浄書  

(Engrave)」▸「フォントスタイル (Font Styles)」で、「小節リピート記号のカウント (Bar 

repeat count)」のフォントスタイルを編集します。 

小節リピート記号の上に表示される数字の詳細な位置は、浄書モードでマウスまたは 

[Alt]+ 矢印キーでナッジすることで調整できます。 

小節リピート記号をグループ化する: 規則性の高いフレーズ構造を持つ楽譜におい

ては、小節リピート記号をグループ化することによってその構造を示すことが望ましい

場合があります。たとえば、4 小節周期の構造を持つ楽譜においては、まったく同じ 

2 つの 4 小節フレーズを次のように表示できます。 

 

 
 
 
 
 
 
 
 
 
 
 
 

または、次のように 4 小節間隔によるグループ化もできます。 

 
 
 
 
 
 
 
 
 
 
 
 
 

あまり一般的ではありませんが、1 つめの 4 小節フレーズは、次のように 3 小

節のリピート記号を使用して表示することもできます。 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

グループ化を有効にするには、小節リピート記号のいずれか、または小節リピート領

域の両端にあるいずれかのハンドルを選択し、「この小節数ごとにグループ化 
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(Group  

every)」プロパティを任意の小節数に設定します。4 小節フレーズを完成させたとき

に 3 小節のリピート記号を表示するには、浄書オプションの「小節リピート記号 

(Bar Repeats)」ページにある「グループの余り 3 小節の外観 (Appearance for 

three-bar remainder of group)」を「3 小節リピート記号を使用 (Use 3-bar 

repeat)」に設定します。 

[Shift]+[R] でポップオーバーを開いて小節リピート領域を作成する場合でも、グル

ープ化を指定できます。たとえば、「%1,4」と入力すると、1 小節のリピート記号を 4 

小節ごとにグループ化し、「%2,4」と入力すると、2 小節のリピート記号を 4 小節ご

とにグループ化します。グループ化は 1 小節、2 小節または 4 小節においてのみ

指定できます。入力された数字の組み合わせが無効であると Dorico が判断した場

合は、デフォルト状態 (グループ化なし) になります。 

あいまいさを招く場合もあるため、小節リピート記号のグループ化は慎重に行なうよう

に注意してください。 

1 つにまとめられた小節リピート領域に内包された小節場号の範囲は、レイアウトオ

プションの「小節番号 (Bar Numbers)」ページにある「長休符および統合された小節

リピート記号の下に小節番号の範囲を表示 (Show ranges of bar numbers 

under  

multi-bar rests and consolidated bar repeats)」オプションをオンにすることで、1 

つにまとめられた小節リピート記号の下に表示できます。 

 
編曲用の新ツール 

Dorico 2 は、マルチペースト、エクスプロードとリデュース、上下譜表への要素の移

動およびコピーなど、編曲中の一般的な作業をアシストする多数の音符編集ツールを

新たに導入しています。 

マルチペースト: コピーした要素をペーストするとき、選択範囲で指定した水平方向お

よび垂直方向の範囲を埋めるマルチペーストを利用できるようになりました。選択した

アイテムが 1 つだけの場合、ペースト結果は従来とまったく変わりませんが、複数ア

イテムが選択されている場合、Dorico は、アイテムが選択されているインストゥルメ

ントの隣接する範囲で描かれる名目上の矩形、1 番上のインストゥルメント上の最初

に選択されたアイテムの位置、および選択範囲内のすべてのインストゥルメントのうち

最後に選択されたアイテムの位置を判断し、選択範囲に収まるよう要素のコピーを完

全な形で繰り返しペーストして、この矩形を埋めようとします。 

インストゥルメントが隣り合わない形で選択されている場合、Dorico は隣り合うインス

トゥルメントの範囲 1 つ 1 つを個別のペースト領域と見なします。これにより、たと

えば 1 つのインストゥルメントから強弱記号をコピーし、これを複数のインストゥルメ

ントにマルチペーストする際、範囲の途中にあるいくつかのインストゥルメントを除外で

きます。 
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選択範囲がコピーした要素より短かった場合でも、Dorico は要素のコピーを完全な

形で選択範囲の各インストゥルメントにペーストしますが、選択範囲がコピーした要素

より長い場合、Dorico は要素のコピーを完全な形でできるだけ多く繰り返して、選択

範囲からはみ出さないようにペーストします。(STEAM-7450) 

楽譜を上か下の譜表に移動する: 「編集 (Edit)」▸「形式を選択して貼り付け (Paste  

Special)」サブメニューに 2 つの新しいコマンドが追加されました。追加されたコマン

ドは「上の譜表に移動 (Move to Staff Above)」と「下の譜表に移動 (Move to 

Staff Below)」で、これらのデフォルトのキーボードショートカットは [Alt]+[N] と 

[Alt]+[M] となります (「編集 (Edit)」▸「譜表まで伸ばす (Cross Staff)」▸「上の譜

表まで伸ばす (Cross to Staff Above)」と「下の譜表まで伸ばす (Cross to Staff 

Below)」のデフォルトのキーボードショートカット [N] と [M] に類似させています)。 

これらのコマンドは、選択した音符などのアイテムを現在の譜表から切り取り、それを

上か下の譜表にペーストする作業を 1 つの操作で完了させます。これはさまざまな

状況でとても便利な機能です。たとえば、MIDI ファイルからキーボードのパートを読

み込んだ後、個別の音符を右手の譜表から左手の譜表へ、または左手の譜表から

右手の譜表へ移動させる必要がある場合や、新機能のエクスプロードまたはリデュー

スを使用した後、個々のボイシングを調整する必要がある場合などに便利です。 

連符に属する音符を上か下の譜表に移動する場合は、連符の数字や角括弧 (また

はガイド) そのものまで選択に含まれていないと、連符は上下の譜表に移動せず、音

符は連符がはずれた状態となりますので注意してください。 

楽譜を上か下の譜表に複製する: 「上の譜表に複製 (Duplicate to Staff Above)」

と「下の譜表に複製 (Duplicate to Staff Below)」が、「編集 (Edit)」▸「形式を選択

して貼り付け (Paste Special)」サブメニューに新しく追加されました。このコマンドは、

「上の譜表に移動 (Move to Staff Above)」と「下の譜表に移動 (Move to Staff 

Below)」と似ていますが、カットアンドペーストではなくコピーアンドペーストを行なうた

め、選択した要素を元の譜表に残しながら上か下の譜表に複製できます。 

リデュース: リダクション (リデュース) では、1 つ以上のインストゥルメントの楽譜を

変換して、より少ないインストゥルメント (キーボードリダクションの場合は 1 つのイン

ストゥルメント) に割り当てます。この手間のかかるタスクを部分的に自動化するため

に、「編集 (Edit)」▸「形式を選択して貼り付け (Paste Special)」▸「リデュース 

(Reduce)」が新しく追加されました。 

まず、リデュースする要素を「編集 (Edit)」▸「コピー (Copy)」でクリップボードにコピ

ーします。次に、コピーした要素のリデュース先となる 1 つ以上のインストゥルメント

を選択して、「編集 (Edit)」▸「形式を選択して貼り付け (Paste Special)」▸「リデュー

ス (Reduce)」を選択します。 

 

Dorico はコピーした要素をペーストする際に、次のような変換を行ないます。リズム
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が一致する要素は単一の声部にマージします。ユニゾンの音符は削除し、所定の位

置の同じ音程には 1 音のみがペーストされるようにします。音部記号の変更、オクタ

ーブ線、キューは取り除きます。 

コピーした要素を選択したインストゥルメントにペーストする際の割り振りは自動的に

決定され、ペースト先のインストゥルメントはすべて少なくとも 1 つのインストゥルメン

トの音符を受け取り、必要に応じてそのインストゥルメントの音符を複製します。たとえ

ば、4 つのインストゥルメントから要素をコピーして 2 つのインストゥルメントにリデュ

ースする場合、要素は上のインストゥルメントから順に、2 つのインストゥルメントに均

等に分割されます。5 つのインストゥルメントから要素をコピーして 3 つのインストゥ

ルメントにリデュースする場合は、リデュース先の 1 つめのインストゥルメントにはコ

ピー元の 1 つめと 2 つめのインストゥルメントから、同様に 2 つめには 3 つめと 

4 つめから、3 つめには 5 つめからの要素が割り当てられます。 

エクスプロード: エクスプロードとは、いくつか (通常 1 つか 2 つ) のインストゥルメ

ントの楽譜を変換して、より多くのインストゥルメントにペーストすることを「エクスプロ

ード」と言い表わしたものです。これが「編集 (Edit)」▸「形式を選択して貼り付け 

(Paste Special)」▸「エクスプロード (Explode)」から実行できるようになりました。 

まず「編集 (Edit)」▸「コピー (Copy)」を使用して、エクスプロードさせる要素をクリッ

プボードにコピーします。次に、コピーした要素をエクスプロードさせる先のインストゥ

ルメントを 1 つ以上選択して、「編集 (Edit)」▸「形式を選択して貼り付け (Paste 

Special)」▸「エクスプロード (Explode)」を選択します。 

Dorico は、出力先のインストゥルメントがそれぞれ、元となる和音の上から順に、必

ず 1 音は受け取るようにします。和音を構成する音符の数が出力先のインストゥル

メント数と一致する場合、インストゥルメントはそれぞれ 1 音ずつ受け取ります。和音

を構成する音符の数が出力先のインストゥルメント数より少ない場合、2 つ以上のイ

ンストゥルメントに同じ音符が割り当てられます。 

スラーや強弱記号などの音符ではないアイテムも、出力先のそれぞれのイン

ストゥルメントに複製されます。 
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演奏技法エディター 

新設された「浄書 (Engrave)」▸「演奏技法 (Playing Techniques)」ダイアログより、

既存の演奏技法を編集してオリジナルを作成できるようになりました。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

既存の演奏技法を編集する: 既存の演奏技法を編集するには、ダイアログの左上隅

にある「演奏技法のカテゴリー (Playing Technique Cateory)」メニューから適切な

カテゴリーを選択します。これは記譜モードの「演奏技法 (Playing Techniques)」パ

ネルに表示されるカテゴリーに対応します。選択したカテゴリーの演奏技法がメニュー

のすぐ下のリストに表示されます。選択している演奏技法が、ダイアログの右側を占

めるメインエディターに表示されます。 

エディターは、選択した演奏技法のタイプに応じて外観が変わります。「テキスト  

(Text)」の演奏技法はスコアに表示されるテキストを表示します。「グリフ (Glyph)」の

演奏技法はグラフィックによる記号を表示します (通常は音楽フォントからの文字を  

1 つ以上使用しますが、実際は音楽フォント、テキストフォント、さらには画像ファイル

まで自由に組み合わせて使用できます)。 

「テキスト (Text)」の演奏技法は、このダイアログで直接編集できます。「テキスト  

(Text)」フィールドを編集して表示されるテキスト内容を変更し、そのすぐ右のメニュー

から使用するフォントスタイルを選択して指定します。デフォルトでは、使用するフォン

トスタイルは、「演奏技法用フォント (Playing technique font)」に指定されていま

す。 
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「グリフ (Glyph)」の演奏技法では、編集のために第 2 のダイアログを開きます。譜

表の上と下で、演奏技法の外観が同じか異なるかによって、ダイアログ上半部の大プ

レビューのアクションバーに鉛筆アイコンが 1 つ、または 2 つの外観に鉛筆アイコ

ンが 1 つずつ表示されます。鉛筆アイコンをクリックすると、第 2 のエディターが開

きます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

演奏技法に新規の要素を追加するには、ダイアログ右側のパネルから選択します。

「グリフ (Glyph)」タブからは、任意のフォントの任意の文字を選択できます。「テキス

ト (Text)」タブからは、任意のフォントスタイルの単語を 1 つ以上入力できます。「グ

ラフィック (Graphic)」タブからは、SVG、PNG、または JPG フォーマットのグラフィ

ックをインポートできます。「組み合わせ (Composite)」タブからは、プロジェクト全体

で使用される既存の音楽記号を追加できます。 

追加した要素は、マウスドラッグまたは [Alt]+矢印キーで移動できます。要素はそれ

ぞれ、ハンドルのいずれか 1 つをクリックしてドラッグするか、「X スケール (X 

scale)」と「Y スケール (Y scale)」のスピンコントロールを使用して表示倍率を変更

できます。グラフィック要素は水平方向と垂直方向の倍率を独立して変更できますが、

グリフ、テキスト、組み合わせの要素においては、倍率は両方向に均等で変更する必

要があります。 

複数の要素が重なり合う場合は、「前後の順序 (Z order)」ボタンを使用して選択した

要素を前後に移動させることで、各要素の表示の前後関係を決定できます。 

演奏技法のデザインが完成したら、「OK」をクリックして第 2 のエディターを閉じ、メ

インダイアログに戻ります。 
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メインのプレビューパネルの下にあるその他のオプションは、以下のとおりです。 

 カテゴリー (Category): カテゴリーを選択して、この演奏技法を「演奏技法  

(Playing Techniques)」パネルのどのセクションに表示するかを決定します。 

 デフォルトの位置 (Default placement): 演奏技法のデフォルトの表示位置を、

譜表の「上 (Above)」か「下 (Below)」か指定します。 

 外観 (Appearance): グリフタイプの演奏技法のみに適用されます。「上下とも同

じ (Same above and below)」は、演奏技法を譜表の上または下に表示する際、

いずれも同じ記号を使用することを意味します。「上下によって異なる (Different  

above and below)」では、譜表の上下によって異なる記号を指定できます。 

 ポップオーバーテキスト (Popover text): この演奏技法を記譜するために 

[Shift]+[P] のポップオーバーに入力するテキストを指定します。すでに他の演奏

技法に割り当てられているテキストを指定すると、エディターが警告を発します。 

 演奏技法 (Playing technique): 再生時に実際に発動する演奏技法です。次項

を参照してください。 

 デュレーション (Duration): 予定されている演奏技法の延長線表示のオプション

が Dorico にすべて実装されてはいないため (現在のグリフの繰り返し表示に加

えて、実線、破線、およびさまざまな種類の矢印が追加される予定です)、現時点

での効果は限られますが、今後の開発により、演奏技法がデフォルトで延長線を

表示する (「デュレーションあり (Has duration)」) か、1 か所の位置のみに適用

される (「デュレーションなし (Has no duration)」) かを指定できるようになりま

す。 

 キューでの表示 (Shown in cues): キューが参照元のインストゥルメントから演

奏技法を含める設定になっている場合、この演奏技法をキューに表示するかしな

いかを指定します。 
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再生用の演奏技法: 「浄書 (Engrave)」▸「演奏技法 (Playing Techniques)」ダイ

アログで外観を編集した演奏技法はすべて、再生用の演奏技法に関連付けられてい

ます。演奏技法の外観を編集するときに、「演奏技法 (Playing Techniques)」メニュ

ーから選択できます。また、「演奏技法 (Playing Techniques)」メニュー右側の「編

集 (Edit)」ボタンをクリックすると、以下のダイアログが表示され、既存の再生用の演

奏技法を編集してオリジナルの定義を行なえます。 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

左上隅の「演奏技法のグループ (Playing Technique Group)」メニューは、どのグ

ループに属する再生用の演奏技法を編集するかを選択できます。これらのグループ

は VST エクスプレッションマップ形式で定義され、音符の再生に与える効果のタイプ

を指定します。 

 演奏技法 (Techniques): 全体的なサウンドの性質に影響を与える演奏技法で

す。 

 強弱記号 (Dynamics): サウンドの音量またはアタックに影響を与える演奏技法

です。 

 長さ (Lengths): 音符を演奏するデュレーションや、レガートやデタシェのようなサ

ウンドの性質に影響を与える演奏技法です。 

 装飾音 (Ornaments): 書き込まれたピッチに対し追加の音や異なる音を加えた

り、音のピッチやビブラートを変化させたりする演奏技法です。 
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右側の「名前 (Name)」は、「浄書 (Engrave)」▸「演奏技法 (Playing 

Techniques)」、「再生 (Play)」▸「エクスプレッションマップ (Expression Maps)」、

および「再生 (Play)」▸「パーカッションマップ (Percussion Maps)」のダイアログ内

のリストにおいて、この演奏技法がどのように表示されるかを決定します。再生用の

演奏技法にはそれぞれ以下の値を設定できます。 

 エイリアス元 (Alias for): 効果を模倣する再生用の演奏技法を指定します。 

 グループ (Group): この再生用の演奏技法が表示されるグループを指定します。 

 代替 (Fallback): この演奏技法が使用できない場合、かわりに使用する再生用

の演奏技法を指定します。 

 アーティキュレーションのタイプ (Articulation type): 再生用の演奏技法が与え

る効果のデュレーションを指定します。「単音 (Attribute)」はその位置の音符の

みに適用され (スタッカートのアーティキュレーションなど)、「持続 (Direction)」は

以降のすべての音符に、他の演奏技法によって取り消されるまで効果を与え続け

ます (ピチカートの指示など)。 

変更を終えたら「OK」をクリックします。これで、編集または新規作成された再生用の

演奏技法をプロジェクトで利用できるようになります。 

編集した演奏技法を他のプロジェクトで使用できるようにする: 「浄書 (Engrave)」▸

「演奏技法 (Playing Techniques)」で行なった編集はすべて、デフォルトでは現在

のプロジェクトだけに適用されます。新規作成または編集した再生用の演奏技法を今

後作成するすべてのプロジェクトで利用できるようにするには、ダイアログ左側のリス

トから該当する演奏技法を選択して、「デフォルトとして保存 (Save as Default)」をク

リックします。この演奏技法は、今後作成されるすべての新規プロジェクトに反映され

ます。 

デフォルトの演奏技法に加えた編集を元に戻すには、ダイアログ左側のリストから該

当する演奏技法を選択して、「出荷時の設定に戻す (Revert to Factory)」をクリック

します。 
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手書き音楽フォント「Petaluma」 
 

Dorico 2 には、手書きの音楽フォントファミリーである「Petaluma」が新たに加わりま

した。このファミリーは、「Petaluma」、「Petaluma Text」、「Petaluma Script」の 3 つ

のフォントで構成されています。「Petaluma」は、スコア中のすべての音楽記号に使用

されるメインのフォントです。「Petaluma Text」は、メトロノームマーク、コード記号、強

弱記号など、テキストのようなアイテムに書き込まれる音楽記号に使用されます。

「Petaluma Script」は、スコア中のその他すべてのテキストでの使用に適したスクリプ

トフォントです。 

 
 
 
 
 
 
 
 
 
 

Petaluma ファミリーは、Jazz Standards を扱う一般的な譜面集で使用される手書

きスタイルにおおよそ基づいていますが、1350 以上の音楽記号と 500 以上の字形

のレパートリーを有し、これは単体セットで刊行されている出版物の中でも、はるかに

バラエティーに富むものとなります。 

プロジェクトで Petaluma を使用するには、「浄書 (Engrave)」▸「音楽フォント 

(Music Fonts)」を選択し、使用できる音楽フォントのリストから「Petaluma」を選んで

「OK」をクリックします。これにより、「Petaluma Script」もプロジェクトのデフォルトの

テキストフォントになります。他のテキストフォントを使用する場合は、「浄書 

(Engrave)」▸「フォントスタイル (Font Styles)」の「デフォルトのテキスト用フォント 

(Default text font)」、および「浄書 (Engrave)」▸「段落スタイル (Paragraph 

Styles)」の「デフォルトのテキスト (Default text)」を編集します。 

Petaluma は SMuFL 互換の音楽フォントであり、SIL Open Font License (OFL) 

のライセンスを受けています。したがって、OFL の下で変更をリリースする限りは、自

由に使用、変更、配布を行なえます。「Petaluma」はこのフォントファミリーの予約フォ

ント名であり、派生フォントはこのフォント名を使用できません。最後に、フォントファミ

リー「Petaluma」およびその派生フォントは、個別に販売できませんが、市販されるパ

ッケージの一部として配布できます。 
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NotePerformer 3 のサポート 

Dorico 2 は、Wallander Instruments による NotePerformer 3 のサポートも導入

しています。NotePerformer は、楽譜作成ソフトウェアによる再生のために特別に設

計されたバーチャルインストゥルメントです。 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NotePerformer 3 は Dorico 2 に内蔵されていませんが、

www.noteperformer.com より別途購入できます。また、ここから 30 日無料トライア

ル版をダウンロードできます。 

 

NotePerformer 3 を購入しインストールした後 Dorico で使用するには、

NotePerformer を使用して再生を行なうプロジェクトを開き、「再生 (Play)」▸「再生テ

ンプレート (Playback Templates)」を選択します。再生テンプレートのリストから

「NotePerformer」を選択して「OK」をクリックします。 

NotePerformer をすべての新規プロジェクトで使用する場合は、「環境設定  

(Preferences)」の「全般 (General)」ページの「再生 (Play)」セクションにある「デフ

ォルトの再生テンプレート (Default playback template)」を「NotePerformer」に設

定します。 

  

http://www.noteperformer.com/
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改善点 
臨時記号 

HALion Sonic SE やその他の VST ノートエクスプレッション対応 VST 3 インスト

ゥルメントにおいて、再生中および楽譜上の音符選択時の試し聴きの際に、微分音の

臨時記号が正確に再生されるようになりました。 

 

オーディオ書き出し 

Mac および Windows で、オーディオ書き出し中の進捗ダイアログが表示されるよ

うになり、実行中の実際の進捗をより正確に把握できるようになりました。

(STEAM-5293) 

 

小節線 

讃美歌スタイルの反復小節線: The New English Hymnal などの一部の讃美歌集に

は、反復小節線の独特な描写法が見られます。すべてのスペースの間に点が表示さ

れ、細い線と太い線の組み合わせのかわりに 2 本の細い小節線が描かれます。た

だし、組段の開始位置は例外で、小節線がなく 4 つの点だけが表示されます。浄書

オプションの「小節線 (Barlines)」ページにある「同じ位置にある反復記号 (縦線型) 

の外観 (Coincident repeat barline appearance)」を「細い複縦線 (Double thin 

barlines)」に、「リピートの点の数 (Repeat dot frequency)」を「譜表内のすべての

スペース (All spaces in the staff)」に設定することで、この表記規則に対応できる

ようになりました。(STEAM-7668) 

 
小節番号 

長休符の小節番号の範囲: 長休符に含まれる小節番号の範囲を表示できるようにな

りました。これは長休符の真下に表示されます。これを有効にするには、レイアウトオ

プションの「小節番号 (Bar Numbers)」ページにある「長休符では小節番号の範囲

を表示 (Show ranges of bar numbers under multi-bar rests)」をオンにします。 

浄書オプションの「休符 (Rests)」ページに新しいオプションが追加され、譜表とその

下の小節番号の範囲表示とのデフォルトの距離の変更と、範囲表示の 1 つめと 2 

つめの小節番号の区切り文字の指定を行なえるようになりました。(STEAM-7791) 

異なるレイアウトにおける小節番号の外観: レイアウトオプションの「小節番号 (Bar  

Numbers)」ページにパラグラフスタイルが新しいオプションとして追加され、プロジェ

クトの各レイアウトにどのパラグラフスタイルを使用するかを選択できるようになりまし

た。新規プロジェクトでは、フルスコアおよびカスタムスコアが「小節番号 (スコア) 

(Bar numbers (score))」のパラグラフスタイルを使用する一方、パートレイアウトは

「小節番号 (パート) (Bar numbers (parts))」のパラグラフスタイルを使用します。既

存のプロジェクトでは、スコアレイアウトとパートレイアウトのいずれも「小節番号 (ス

コア) (Bar numbers (score))」のパラグラフスタイルを使用しますが、これは Dorico 

1.x で使用される小節番号のフォントスタイルの外観に一致するように更新されてお
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り、Dorico 2 でプロジェクトを開いても小節番号の外観が変わらないようにしていま

す。 

デフォルトでは、「小節番号 (スコア) (Bar numbers (score))」と「小節番号 (パート)  

(Bar numbers (parts))」のパラグラフスタイルはいずれも同じ外観を持ちますが、個

別にスタイルを持つことにより、フルスコアに影響を与えずに、パートレイアウトの小

節番号のフォント、サイズ、スタイルを簡単に変更できます。(STEAM-7813) 

 
コード記号 

カラー: コード記号が、プロパティの「一般 (Common)」グループの「カラー (Color)」

プロパティの設定に従うようになりました。(STEAM-6493) 

 
音部記号 

実音および移調音で使用される音部記号を指定する: Dorico にプリセットされている

インストゥルメントタイプには、実音と移調音の楽譜を表示する際にそれぞれ異なる音

部記号を使用するものがあります。必要に応じて、フローの音部記号それぞれにこれ

を直接指定できるようになりました。「編集 (Edit)」▸「音部記号 (Clef)」サブメニュー

に、「実音 (Concert Pitch)」と「移調音 (Transposed Pitch)」の 2 つのサブメニュ

ーが新しく追加されました。ここからは、記譜モードの「音部記号 (Clefs)」パネルから

利用できるすべての音部記号が選択できます。(STEAM-7676) 

 
強弱記号 

強弱記号の背景を塗りつぶす: 局部的強弱記号に先頭テキストまたは末尾テキスト

が付く場合、テキストベースの段階的強弱記号が小節線をまたぐ場合、またはごくま

れな状況として、強弱記号が譜表の内側に配置されてしまう場合、強弱記号で小節

線や譜表線の一部を塗りつぶせるようにすることで、強弱記号がかなり読みやすくな

ります。 

プロパティパネルの「強弱記号 (Dynamics)」グループに、「背景を塗りつぶし 

(Erase background)」プロパティが新たに追加されました。これは、浄書モードでの

み表示されます。このプロパティをオンにすると、強弱記号周辺の領域が少し塗りつ

ぶされます。強弱記号周辺の余白のデフォルトの大きさは、浄書オプションの「強弱

記号 (Dynamics)」ページに新たに設置された「強弱記号周辺の背景を塗りつぶし

た余白 (Padding around dynamic with erased background)」の値により決定

されます。プロパティパネルの「強弱記号 (Dynamics)」グループに新たに設置され

た「余白を消去 (Erasure padding)」プロパティを有効にして設定を上書きすること

もできます。 

余白の形状を決定する際、Dorico は先頭テキストおよび末尾テキストを、ダイナミッ

クレベルを示すボールドイタリック体の文字とは区別して見なすため、f risoluto のよ

うな強弱記号に余白を設ける場合、f のための余白は risoluto のための余白よりも

長くなります。余白は、デフォルトで文字の上下への突き出し部分にも反映されるため、
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強弱記号のどの部分で小節線をまたぐかによっては、塗りつぶされる領域が必要以

上に大きく見える場合があります。たとえば、強弱記号の末尾テキスト espressivo 

が「p」ではなく「s」の部分で小節線をまたぐ場合、強弱記号の下の余白が大きすぎる

ように見えます。この解決策として、強弱記号周辺の余白の 4 方向それぞれの大き

さを個別に上書きできます。テキストの突き出し部分より下まで余白を広げないように

下余白を減らして、塗りつぶした領域が文字の上下で対称に見えるように調整しま

す。 

塗りつぶされた余白領域は、強弱記号の衝突回避用の境界線を構成する一部として

見なされます。(STEAM-7656) 

終端の広がったヘアピン: 終端の広がったヘアピンは、ダイナミックレベルの急激な

増大または減少を示すために一部の作曲者によって使用され、「急激なヘアピン」と

呼ばれる場合もあります。ヘアピンの終端に広がりを付けるには、ヘアピンを選択し

て、新しく追加された「終端の広がり (Flared end)」プロパティをオンにします。このプ

ロパティはヘアピンとして描かれる段階的強弱記号で、実線で描かれるものでのみ使

用できます。 

終端の広がりのデフォルトのサイズは、浄書オプションの「強弱記号 (Dynamics)」

ページの「段階的強弱記号 (Gradual Dynamics)」セクションに新設された「終端が

広がったデザイン (Flared end design)」グループ内のオプションを変更して指定し

ます。個々のヘアピンの終端の広がりのサイズは、浄書モードで、新しく追加された

「広がりのサイズ (Flare size)」プロパティの「幅 (W)」と「高さ (H)」を変更して調節し

ます。(STEAM-7778) 

 
フィルター 

「編集 (Edit)」▸「フィルター (Filter)」メニューにマーカー、小節リピート領域およびス

ラッシュ領域が追加されました。またフィルターメニューは、右クリックによるコンテキ

ストメニューの中に含まれるようになったため、簡単に呼び出すことができます。 

 
フィンガリング 

カスタム倍率: プロパティパネルの「フィンガリング (Fingering)」グループに「スケー

ル (Scale)」プロパティが新しく追加されました。これは浄書モードでのみ表示され、フ

ィンガリングの表示倍率を、それが属する音符の表示倍率とは別に変更できます。 

(STEAM-7346) 

親切フィンガリングの外観: プロパティパネルの「フィンガリング (Fingering)」グルー

プに新しく追加された「親切臨時記号 (Cautionary)」から、親切フィンガリングの外観

を個別に上書きできるようになりました。これは浄書モードで (フィンガリングではなく) 

音符が選択されているときだけ表示されます。このプロパティは、親切フィンガリング

が付いた音符の場合でのみオンにできます。それ以外の音符では自動的にオフに戻

されます。プロパティがオンになると、以下の値から選択できるようになります。
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(STEAM-7345) 

 

 デフォルト (Default): 浄書オプションで設定された親切フィンガリングの外観を使

用します。 

 括弧なし (No parentheses): フィンガリングを括弧なしで表示します。 

 括弧つき (With parentheses): 括弧を付けてフィンガリングを表示します。 

 抑制 (Suppress): 親切フィンガリングを完全に非表示にします。 

丸付きまたは下線付きのフィンガリング: フィンガリングに丸い囲み線または下線を付

けることができるようになりました。このような装飾はアコーディオンのフィンガリングで

使用される場合があり、指でヘルプ行を押さえて演奏することを示します。これを有効

化するには、フィンガリング番号を選択して、プロパティパネルの「フィンガリング  

(Fingering)」グループに新しく追加された「デコレーション (Decoration)」プロパティ

をオンにします。これは浄書モードでのみ表示されます。浄書オプションの「フィンガリ

ング (Fingering)」ページの「デザイン (Design)」セクションで「詳細設定 

(Advanced Options)」サブセクションを展開すると、丸い囲み線のサイズ、線の太さ

などのオプションを設定できます。(STEAM-7308) 

 
ギャレービュー 

余白部分の譜表ラベルおよび最上段の譜表の上の小節番号のサイズと位置が改善

されました。 

 
HALion Sonic SE (STEAM-7672) 

Dorico 2 は HALion Sonic SE 3 を搭載しました。新しいバージョン用に更新された

オペレーションマニュアルについては、以下のサイトを参照してください。 

https://steinberg.help/vst-manuals/halion/halion-sonic-se-3/ 

 
ミキサー 

ボリュームフェーダーまたはパンコントロールにおいて、[Ctrl]+クリック (Windows) 

または [Command]+クリック (Mac) すると、デフォルト値にリセットできるようになり

ました。(STEAM-8046) 

 
音符 

符尾なしの音符: プロパティパネルの「音符と休符 (Notes and Rests)」グループに

「符尾を非表示 (Hide stem)」プロパティが新たに追加されました。これは浄書モード

でのみ表示されます。オンにすると、選択した音符の符尾が表示されなくなり、同時に

符鉤も非表示になります。選択した音符が連桁のグループに入っている場合、符尾

は非表示になりますが、連桁は通常どおりに表示されます。ただし、連桁のグループ

に属する音符すべてで「符尾を非表示 (Hide stem)」プロパティがオンに設定された

場合は、連桁も非表示になります。(STEAM-7494) 

  

https://steinberg.help/vst-manuals/halion/halion-sonic-se-3/
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音符の入力 

既存の音符を連符に組み込む: 選択した既存の音符を 1 つ以上の連符に組み込

めるようになりました。連符に変換する音符を選択して、「;」 (セミコロン) を押します。

連符のポップオーバーが開き、選択した音符の数とデュレーションから提案される比

率が表示されます。提案された比率のまま、または任意の比率を入力してから、

[Return] を押してポップオーバーを確定します。選択した音符が指定した比率の連

符 1 つに収まる場合は、連符が 1 つだけ作成されます。指定した比率が選択した

音符すべてを組み込むには不十分である場合は、選択したすべての音符が連符に

収まるまで追加の連符が作成されます。 

音符のデュレーションに対応する文字 (2h = 2 全音符、w = 全音符、h = 2 分音符、 

q = 4 分音符、e = 8 分音符など) または音符入力のデフォルトのキーボードショート

カットにおけるデュレーションに対応する数字 (9 = 2 全音符、8 = 全音符、7 = 2 分

音符、6 = 4 分音符、5 = 8 分音符など) を付加することにより、連符の拍の単位を

連符のポップオーバーに直接指定できるようになりました。また、1 つ以上の終止符 

(ピリオド) 文字を加えることで、付点付きの拍の単位を指定できます。デュレーション

の指定に数字を使用する場合、拍数と拍の単位をスペースかハイフンで区切る必要

があります。たとえば、「5:4q.」は「付点 4 分音符 4 つの長さによる 5 連符」となり、 

「3:2-2w」は「2 全音符 2 つの長さによる 3 連符」となります。(STEAM-4129) 

 
音符のスペーシング 

対立する符尾: 隣接する譜表の対立する符尾が接触しないように、符尾の先端にわ

ずかな余白が与えられました。接触しそうな場合は、譜表間に強制的に距離が取ら

れます。(STEAM-7490) 

 
打楽器 

打楽器のレジェンド: 打楽器のレジェンドが、リハーサルマークおよびテンポ指示テキ

ストの内側に配置されるようになりました。(STEAM-7602) 

 
再生テンプレート (STEAM-7760) 

再生テンプレートには、VST インストゥルメントまたは MIDI デバイスからのサウンド

をプロジェクトのインストゥルメントに配置するために Dorico が使用するルールが記

載されています。これまでは、デフォルトの再生テンプレートは 1 つだけで、プロジェ

クトの再生に HALion Sonic SE のインスタンスおよび内蔵されている HALion 

Symphonic Orchestra と HALion Sonic SE のライブラリーのコンテンツを使用して

いました。オリジナルのサウンドまたは VST インストゥルメントを割り当てて、デフォ

ルトの再生テンプレートの使用を上書きすることはできましたが、それを行なうと、デフ

ォルトの再生テンプレートの適用を指示しない限り、Dorico は自力でサウンドの割り

当てを行なわなくなっていました。 

  



 

Dorico 2 バージョン履歴 75ページ Steinberg Media Technologies GmbH 

 

デフォルトの再生テンプレート: 新登場の入門編である Dorico Elements は、

HALion Symphonic Orchestra 音源を搭載していないため、デフォルトの再生では 

HALion Sonic SE ライブラリーのコンテンツに完全に依存します。このため、Dorico 

Pro はデフォルトの再生テンプレートとして、「HSSE+HSO (Pro)」と「HSSE 

(Elements)」の 2 つを提供しています。前者は Dorico 1.x のデフォルトの再生テ

ンプレートと同じです。後者は HALion Symphonic Orchestra のサウンドを一切使

用せず、Dorico Elements のデフォルトの再生テンプレートと同じものとなります。 

新規プロジェクトにどの再生テンプレートを使用するかを指定するために、「環境設定 

(Preferences)」の「全般 (General)」ページの「再生 (Play)」セクションに「デフォルト

の再生テンプレート (Default playback template)」オプションが追加されました。 

現在のプロジェクトに異なる再生テンプレートを選択する、またはデフォルトの再生テ

ンプレートのいずれかを適用するには、「再生 (Play)」▸「再生テンプレート 

(Playback Template)」を選択し、リストから使用する再生テンプレートを選択しま

す。 

再生テンプレートをさらに追加する: Dorico は、再生テンプレートをさらに追加するた

めに、システム全体またはユーザー固有のアプリケーションデータフォルダーに位置

する、「PluginPresetLibraries」および「PlaybackTemplateGenerators」というフ

ォルダー内のサブフォルダーからデータを読み込みます。フォルダー位置は以下のと

おりです。 

 Windows:%PROGRAMDATA%¥Steinberg¥Dorico 2 (システム全体) または  

%APPDATA%¥Steinberg¥Dorico 2 (ユーザー固有) 

 macOS:/Library/Application Support/Steinberg/Dorico 2 (システム全体) 

または ~/Library/Application Support/Steinberg/Dorico 2 (ユーザー固有) 

これらのフォルダー内の各サブフォルダーの名前が、Dorico における再生テンプレ

ートの表示名となります。 

「PluginPresetLibraries」内の指定されたサブフォルダーから、以下の 2 つのファ

イルがロードされます。 

 Presets.xml: バーチャルインストゥルメントのライブラリー内のすべてのプリセット

またはパッチのリストです。各項目に対応するエクスプレッションマップまたはパー

カッションマップの名称を定義します。 

 Presets_for_instruments.xml: Dorico 内に作成できるデフォルトのインストゥ

ルメントタイプすべてと、そのインストゥルメントにデフォルトで読み込まれるプリセ

ットのリストです。 

「PlaybackTemplateGenerators」内の指定されたサブフォルダーには、 

playbacktemplategen.xml というファイルが存在しなければなりません。これは、

読み込まれる VST インストゥルメント の UID、使用する「PluginPresetLibraries」
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のデータ、およびその他いくつかのパラメーター (たとえば、インストゥルメントから提

供される MIDI チャンネル数、オーディオ出力の数、エフェクトチャンネル用のデフォ

ルトの Send ドレベルなど) を指定します。サブフォルダーにはオプションとし

て .pluginstate ファイルが含まれる場合があり、VST インストゥルメントの作成時

にインストゥルメントの中に読み込まれます。 

エンドユーザーがこれらのデータファイルを使用して独自の再生テンプレートを作成

することは意図されていません。この情報は、サードパーティー製 VST インストゥル

メントおよびサウンドライブラリーの開発者の利便のために提供されています。 

 
再生 

音符の短縮: 再生オプションの「タイミング (Timing)」ページにある「書き込まれたデ

ュレーションの % で再生: (Play as % of written duration)」オプションが抑制され、

長い音符や遅いテンポで再生される楽譜の音符が短縮されすぎないようになりました。

音符が 4 分音符以下のデュレーションである場合は、指定された長さだけ短縮され

ます。音符が 4 分音符を超える長さである場合は、音符の終わり 4 分音符の長さ

の部分だけが短縮対象となります。この 4 分音符の長さの部分にはその時点にお

けるテンポも反映され、音符は最大で 1 分間 4 分音符 120 個のテンポのときの 

4 分音符に対する指定の割合で短縮されます。(STEAM-7984) 

再生ヘッドを選択位置に移動する: 選択された中から最初のアイテムの位置に再生

ヘッドを移動させる、新しいキーボードショートカット [Alt]+[P] (デフォルト) が追加さ

れました。これは添付ビデオで作業するとき、譜面上の特定の位置がビデオのどのフ

レームに対応するかを確認できるため、非常に便利です。(STEAM-5811) 

 
演奏技法 

演奏技法を非表示にする: 不要な繰り返しを避けるためなど、演奏技法を非表示に

するのが望ましい場合もあります。演奏技法を非表示にするには、演奏技法を選択し

てプロパティの「演奏技法 (Playing Techniques)」グループにある「非表示 

(Hidden)」プロパティをオンにします。ガイドが表示されます。必要に応じて、「ビュー 

(View)」▸「ガイド (Signposts)」▸「演奏技法 (Playing Techniques)」を選択すると、

これ自体を非表示にできます。(STEAM-7646) 

テキストベースの演奏技法の背景を塗りつぶす: 演奏技法が小節線をまたぐ場合、

演奏技法周辺の背景を塗りつぶすと、読みやすくなります。これを実現するために、

プロパティパネルの「演奏技法 (Playing Techniques)」グループに「背景を塗りつ

ぶし (Erase background)」プロパティが新たに追加されました。これは浄書モード

でのみ表示されます。演奏技法周辺の余白のデフォルトの大きさは、浄書オプション

の「演奏技法 (Playing Techniques)」ページに新たに設置された「演奏技法周辺の

背景を塗りつぶした余白 (Padding around playing technique with erased 

background)」オプションにより決定されます。また、「余白を消去 (Erasure 
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padding)」プロパティを有効にして、個々の演奏技法ごとに設定を上書きできます。

(STEAM-7669) 

テキストベースの演奏技法の水平オフセット: 浄書オプションの「演奏技法 (Playing  

Techniques)」ページに、「テキストによる演奏技法の水平オフセット (Horizontal 

offset for text playing techniques)」オプションが新たに追加されました。これはデ

フォルトではスペースがゼロに設定されていますが、たとえばテキストベースの演奏

技法を、それが属する音符または和音より少し左に表示させる場合は、この新しいオ

プションにマイナスの小さな値を設定します。(STEAM-7709) 

 
反復記号 

反復記号の再生: Dorico は、反復記号の再生を限定的にサポートし、リピート括弧

や反復小節線が再生されるようになります。トランスポート上の小節/拍およびタイム

ディスプレイは、反復記号内の現在位置を反映します。オーディオおよび MIDI の書

き出しはどちらも反復記号を含みます。(STEAM-3910) 

[Shift]+[R] のポップオーバー: リピート括弧、単一符尾および複数符尾のトレモロ、

スラッシュ領域、および小節リピート領域を作成するための、デフォルトのキーボード

ショートカット [Shift]+[R] によるポップオーバーが新たに追加されました。ポップオー

バーに入力できる文字または記号は、以下のとおりです。(STEAM-7636) 

単一符尾のトレモロ 
/ ∖ 1 1 ストローク 
// ∖∖ 2 2 ストローク 
/// ∖∖∖ 3 3 ストローク 
//// ∖∖∖∖ 4 4 ストローク 
z zonstem  符尾上の Z マーク 

0 clear  トレモロを削除 

複数符尾のトレモロ 

/ ∖ 1 1 ストローク 

// ∖∖ 2 2 ストローク 

/// ∖∖∖ 3 3 ストローク 

//// ∖∖∖∖ 4 4 ストローク 

0 clear  トレモロを削除 

リピート括弧 

end ending  新規のリピート括弧 

add   既存のリピート括弧にセクションを追加 

スラッシュ領域 

slash   新規のスラッシュ領域 

小節リピート領域 

% %1  最後の小節を反復 

%2   最後の 2 小節を反復 

%4   最後の 4 小節を反復 

%1,2   最後の小節を反復、2 つをグループ化 

%1,4   最後の小節を反復、4 つをグループ化 
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テンポ 

既存のテンポの拍の単位を編集する: プロパティパネルの「テンポ (Tempo)」グルー

プに、「拍の単位 (Beat unit)」プロパティが新たに追加され、選択したテンポアイテ

ムの拍の単位を編集できるようになりました。たとえば、メトロノームマークに表示され

る音価を 4 分音符から付点 4 分音符に変更する場合は、テンポアイテムを選択し

てボタンの列から付点のボタンをオンにするだけで変更できます。(STEAM-7462) 

テンポ範囲の区切り文字: デフォルトでは、テンポ範囲の上限と下限を示す数字の区

切り文字として、En ダッシュが使用されます。異なる区切り文字を使用する場合は、

浄書オプションの「テンポ (Tempo)」ページに新設された「テンポ範囲の区切り  

(Separator for tempo range)」オプションを「カスタムの区切り (Custom 

separator)」に設定し、使用する文字を指定します。(STEAM-7708) 

メトロノームマーク: メトロノームマークの音符に対する付点のスペーシングが改善さ

れました。(STEAM-7473) 

 
テキスト 

枠線: プロパティパネルの「テキスト (Text)」グループに、「枠線 (Border)」プロパテ

ィが新たに追加されました。オンにすると、テキストアイテムの周囲に枠線が表示され

ます。枠線のデフォルトの太さは、浄書オプションの「テキスト (Text)」ページに新設

された「境界線の太さ (Border thickness)」オプションで決定されます。また枠線の

太さは、新しく追加された「境界線の太さ (Border thickness)」プロパティをオンにし

て、個々のテキストアイテムごとに設定を上書きすることもできます。これは浄書モー

ドでのみ表示されます。テキストと枠線の間のデフォルトの余白は、浄書オプションの

「テキスト (Text)」ページにある「テキスト周囲の背景を塗りつぶした余白 (Padding 

around text with erased background)」の値により決定されます。また、プロパテ

ィパネルの「テキスト (Text)」グループにある「余白を消去 (Erasure padding)」プロ

パティを設定して上書きできます。(STEAM-7658) 

衝突回避: プロパティパネルの「テキスト (Text)」グループに「衝突を回避 (Avoid  

collisions)」プロパティが追加され、浄書オプションの「テキスト (Text)」ページで指

定される衝突回避のデフォルト設定を上書きできるようになりました。プロパティが設

定されていない場合、テキストは譜表の上か下のデフォルトの垂直位置に表示され、

他のアイテムとの衝突回避が行なわれません。浄書モードでは、通常の方法で位置

を調整できます。(STEAM-7670) 

さらに、浄書オプションの「テキスト (Text)」ページには、「はみ出たアイテムからの最

小距離 (Minimum distance from protruding items)」オプションが新たに追加さ

れ、テキストアイテムと譜表からはみ出たその他のアイテム (音符やスラーなど) と

の間に必要な余白を指定できます。これまでは、テキストアイテムとはみ出したアイテ

ムとの接触は回避されていませんでした。(STEAM-7696) 
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ページ番号のトークン: Dorico 2 では、以下のトークンが新たに追加され、テキストフ

レームに入力できます。 

 

 {@pageCount@}  – レイアウトの総ページ数 

 {@flowPage@}  – 現在のフロー内のこのページの番号。フローの最初のペー

ジを 1 としてカウントします (つまり、表示されるページ番号ではありません)。 

 {@flowPageCount@}  – 現在のフローの総ページ数 

 {@flownFirstPage@}  – フロー n が開始されるページの、表示されるページ

番号。設定モードの「フロー (Flows)」パネルに表示されるフロー番号を n に挿

入します (例: {@flow5FirstPage@})。 

{@flowPage@} と {@flowPageCount@} のトークンは、トークンが使用される位

置であるページの左上隅に最も近い楽曲フレームの、最初の組段の開始位置が有

効化されているフローのみを反映します。(STEAM-7755、STEAM-7766) 

パラグラフスタイルのダイアログ: 「浄書 (Engrave)」▸「段落スタイル (Paragraph  

Styles)」のパラグラフスタイルのダイアログで選択したデフォルトの設定は、最初に

選択されたテキストアイテムで初期化されます (該当する場合)。(STEAM-7972) 

 
ユーザーインターフェース 

見た目を一新: Dorico プロジェクトウィンドウの見た目を少し更新しました。可能な範

囲でパネルの幅と高さを少しずつ減らし、楽譜領域として利用できるスペースを最大

限に広げました。Hub ウィンドウのデザインも変更しました。最近使用したプロジェク

トのリストのスペースが広くなりました。ブログとビデオの投稿リストは、以前は一度に

いずれか 1 つしか見ることができませんでしたが、どちらも表示されるようになり、新

しいコンテンツが利用可能になったときに見つけやすくなりました。 

プレーヤーパネルおよびレイアウトパネルにおける複数選択: 複数のプレーヤーをフ

ローに割り当てるなど、複数のプレーヤーまたはレイアウトを選択して操作を行なう場

合、プレーヤーやレイアウトを選択または除外するときに、該当するチェックボックスを

クリックし、次に [Shift] を押しながら他のチェックボックスをクリックすることで、1 回

めと 2 回めのクリックの範囲内にあるすべてのプレーヤーまたはレイアウトを選択ま

たは除外できます。(STEAM-7287) 

「打楽器キットを編集」のダイアログにおける複数選択: 「打楽器キットを編集 (Edit 

Percussion Kit)」ダイアログの一部の操作を、複数選択したインストゥルメントに対し

て実行できるようになりました。操作には、声部の向きとインデックスの変更、隣接す

るグリッドライン上のインストゥルメントの間隔の設定、キットからのインストゥルメント

の削除、キット内のインストゥルメントの順番の変更などがあります。(STEAM-7289) 
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「元に戻す」と「再実行」: 「編集 (Edit)」▸「元に戻す (Undo)」と「再実行 (Redo)」は、

必要に応じて選択位置に表示が移動するようになりました。「環境設定 

(Preferences)」の「全般 (General)」ページの「編集 (Editing)」セクションに「元に戻

すと再実行は選択変更を追従する (Follow selection on undo and redo)」の環

境設定が新たに追加されました。これをオフにすると Dorico 1.2.10 以前の動作に

戻ります。(STEAM-7564、STEAM-8026) 

 
Dorico 1.x からのアップデート 

Dorico Pro 2 を初めて実行するとき、Dorico 1.x からのユーザーデータおよび環境

設定は自動的に新規更新に移行されます。これには、キーボードショートカット、環境

設定、最近使用したプロジェクトのリスト、保存されたレイアウト、記譜、浄書、再生お

よび音符入力のオプションのデフォルト値、および保存された調性システム、パラグラ

フスタイル、文字スタイルのデフォルト値が含まれます。さらに、Dorico 1.x の 

vst2whitelist.txt ファイルに追加したすべての VST 2.x プラグインは、Dorico 2 

のホワイトリストに自動的に追加されます。(STEAM-7664) 
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Issues resolved 

ID #  Component  Issue  

STEAM-4241  

STEAM-4294  
Accidentals  

Changing the pitch of a grace note before a barline no longer incorrectly considers the 

accidental state of the following bar.  

STEAM-5539  Accidentals  
When using the Second Viennese School accidental system, grace notes are now 

considered correctly when determining whether or not to repeat an accidental.  

STEAM-7472  Accidentals  
Under some rare circumstances, it was not possible to change the pitch of a note that 

had been respelled in a part layout; this problem has now been resolved.  

STEAM-7910  Accidentals  The enharmonic spelling of rising chromatic passages in minor keys has been improved.  

STEAM-7905  Audio export  
A progress dialog now appears during audio export on both Windows and Mac, and 

accurately reflects the actual progress through the operation.  

STEAM-7047  Barlines  
Dashed barlines to show subdivisions in additive time signatures no longer fail to appear 

if the bar is split across a break.  

STEAM-7077  Barlines  
Creating a time signature change at a dashed subdivision no longer causes previous 

dashed subdivisions to appear in the wrong place.  

STEAM-7134  Barlines  
Repeat barlines no longer draw incorrectly at the end of a system if they coincide with a 

key change to a key with no accidentals.  

STEAM-7301  Barlines  
Inserting a barline at the same rhythmic position as an existing dashed subdivision in an 

aggregate time signature now works correctly.  

STEAM-4846  Beaming  
Dragging the end of a stemlet now works correctly when the stemlet belongs to an 

implicit rest.  

STEAM-7562  
Chord 

symbols  
Toggling the Show as mode property on and back off again for a diminished half/whole 

scale chord symbol no longer results in the chord symbol showing as a different chord.  

STEAM-7504  
Collision 

avoidance  
Mysterious problems where deleting an item can cause an item in another bar to move 

vertically in galley view have been resolved.  

STEAM-7716  
Collision 

avoidance  
The extent of items is now always correctly considered for collision avoidance when 

editing an item that is graphically wider than its rhythmic position and duration.  

STEAM-7018  Cues  If a cue abuts the end of a flow, a redundant restorative clef change is no longer created.  

STEAM-7029  Cues  Cues are now automatically removed if they are invalid under more circumstances.  

STEAM-7505  Cues  
Edits that affect where instrument changes occur no longer sometimes cause system 

objects to disappear if a cue is located within the range affected by the edit.  

STEAM-5064  Dynamics  Edit ▸ Reset Appearance and Reset Position now work correctly on dynamics.  

STEAM-6385  Dynamics  
If a dynamic has a color set via Properties, it now shows correctly in the blue linked color 

rather than the orange selection color when another dynamic in the group is selected.  

STEAM-6651  Dynamics  
A series of gradual dynamics interspersed with immediate dynamics and shown as a 

single hairpin no longer draws incorrectly in galley view.  
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ID #  Component  Issue  

STEAM-7328 Dynamics  
Under rare circumstances, edits that affect the vertical placement of gradual dynamics 

would not be propagated to all music frame chains; this has now been resolved.  

STEAM-7742  Dynamics  
Adding an immediate dynamic to the end of an existing group of dynamics now correctly 

extends the length of the flow if required.  

STEAM-7782  Dynamics  Hairpins that extend precisely to the end of the flow now draw correctly in galley view.  

STEAM-7257  Fingering  
The Indicate shift to next note and Shift direction properties for string fingering shift 

indications are now correctly reset when pasting notes onto non-string instruments.  

STEAM-7384  Fingering  
Deferred fingering substitution now works correctly on notes and chords that are tied 

between different voices.  

STEAM-7409  Fingering  
Under some circumstances, fingering substitutions could fail to draw as slurs, despite 

the options or properties; this problem has been resolved.   

STEAM-7217  Flows  
Duplicate Flow and Split Flow now correctly copy the flow info for the original flow into 

the new one.  

STEAM-7697  
Graphics 

export  
Imported graphics are now exported at a much higher resolution when exporting PDF 

files.  

STEAM-7767  
Graphics 

export  
It is no longer possible to change focus to another project in the middle of a graphics 

export operation, which could cause graphics from the wrong project to be exported.  

STEAM-7848  
Holds and 

pauses  
In some circumstances, a fermata on a bar rest could be incorrectly positioned at the 

start of the bar, rather than over the bar rest; this has now been resolved.  

STEAM-4826  
Key 

signatures  
Adding a clef change at the same location as a key change now always correctly 

updates the cancellation naturals, if shown.  

STEAM-7618  
Key 

signatures  
Changing the current tonality system in the Tonality System section of the Key 

Signatures panel now always takes effect correctly.  

STEAM-7628  
Key 

signatures  
Creating a key signature from the Used in this flow section now always uses the 

tonality system selected in the Tonality System section of the Key Signatures panel.  

STEAM-7796  
Key 

signatures  
The tonality system shown in the panel in Write mode is now always used when 

creating a key signature.  

STEAM-7374  Localization  
Changing the keyboard language on the Key Commands page of Preferences now 

works correctly when there are unsaved changes to the key commands in the current 

language.  

STEAM-7563  Localization  The default key command for Write ▸ Respell ▸ Respell Using Note Above now 

works correctly in the German-language version (Windows only).  

STEAM-7361  Lyrics  
Using the left or right arrow key to navigate off the first or last lyric no longer incorrectly 

loses any edit made to that lyric.  

STEAM-6243  
Multi-bar 

rests  
Multi-bar rests are now broken by both the starts and ends of repeat ending segments.  

STEAM-7065  
Multi-bar 

rests  
The presence of a system break no longer sometimes causes the width of a multi-bar 

rest at the end of the previous system to change.  
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ID #  Component  Issue  

STEAM-7423 
MusicXML  

export  
Exporting with Export layouts as separate files switched off now correctly finds and 

uses the most appropriate full score layout for the selected flow.  

STEAM-6118  
MusicXML  

import  
Imported MusicXML and MIDI files now respect the Default text font family preference.  

STEAM-7391  
MusicXML  

import  
A problem that could cause Dorico to crash when importing MusicXML files from 

PDFtoMusic Pro has been resolved.  

STEAM-7957  Navigation  
Moving the selection between non-note items with the arrow keys no longer sometimes 

causes the selection to jump unexpectedly to the start of the previous system in page 

view or backwards several bars in galley view.  

STEAM-7487  
Notation 

options  
The Overlapping notes in the same voice in a kit or grid presentation option on the 

Percussion page of Notation Options now works correctly for chords split by a barline.  

STEAM-5499  Note input  
Inputting the first note in a new voice between rhythmic grid positions now works 

correctly.  

STEAM-5555  Note input  
Under some circumstances, extending the duration of a note that ends within a tuplet in 

Insert mode could cause other later notes in the same voice to be deleted; this problem 

has now been resolved.  

STEAM-6546  Note input  
Changing the voice of a selection of notes no longer sometimes causes the notes to be 

moved to a different rhythmic position if items already exist in the destination voice.  

STEAM-7411  Note input  
Pasting a selection beginning with implicit rests immediately followed by a tuplet no 

longer causes some non-note items to be offset incorrectly.  

STEAM-7411  Note input  
Pasting a selection that begins with implicit rests followed by a tuplet no longer results in 

non-note items being pasted into incorrect rhythmic positions.  

STEAM-7425  Note input  
Pasting a selection including tuplets into an existing passage with identical tuplets with 

chord mode active no longer sometimes results in some of the material being offset.  

STEAM-7449  Note input  
Pasting material of the same duration as an existing tuplet will now remove the tuplet, 

instead of pasting the material into the tuplet.  

STEAM-7561  Note input  
Undoing the creation of a tuplet no longer sometimes fails if a non-note item is located 

within the range of the added tuplet.  

STEAM-7609  Note input  
Making a selection on a percussion kit using the five-line staff presentation type now 

correctly uses the extent of the selection from all components, rather than only the first.  

STEAM-7657  Note input  
Copy and paste for instruments within a percussion kit using the single-line instruments 

presentation type now works more reliably.  

STEAM-7748  Note input  
Dorico no longer hangs when attempting to shorten with Shift+Alt+left arrow a note or 

rest of the minimum valid duration (1024th note).  

STEAM-7880  Note input  
Moving the caret after priming a new voice no longer causes a voice with the wrong 

direction to be created.  

STEAM-7939  Note input  
When multiple items are selected, hitting Return now starts note input, rather than 

attempting to edit the first selected item.  

STEAM-7490  Notes  
Stems in opposing directions on adjacent staves are padded by a small amount to 

prevent them from becoming so close they may appear to touch.  



 

Dorico 2 バージョン履歴 84ページ Steinberg Media Technologies GmbH 

 

ID #  Component  Issue  

STEAM-7508 Notes  
Rhythm dots on stemless notes– i.e. a whole note (semibreve) or longer – in down-stem 

voices are no longer incorrectly snapped to spaces in the wrong direction.  

STEAM-7436  Ornaments  
Glissandos between invalid note positions (for example, two notes of the same pitch tied 

together) are now correctly automatically removed.  

STEAM-7568  Pedal lines  
Making a selection on the lower or left-hand staff of a piano instrument and then pasting 

the pedal line now works correctly.  

STEAM-7684  Pedal lines  
Pedal lines that span multiple systems no longer sometimes disappear when making 

unrelated edits.  

STEAM-7487  Percussion  
The notation option to remove overlaps for percussion kits did not always work correctly 

for a chord split across a barline; this problem has now been resolved.  

STEAM-7568  
Piano 

pedaling  
Pasting piano pedal lines now works correctly when selecting something in the left-hand 

staff of the piano.  

STEAM-7516  Players  
It is no longer incorrectly possible to use the Shift+I key command to add an additional 

instrument to a section player.  

STEAM-7290  Print mode  
The chosen page range for printing is correctly preserved when leaving and re-entering 

Print mode.  

STEAM-7323  Print mode  
Choosing a page range that does not include the first page of the layout, then switching 

back to All pages now updates the print preview correctly.  

STEAM-7764  Print mode  Cancelling a print or graphics export operation no longer sometimes causes a crash  

STEAM-7199  
Repeat 

endings  
It is now possible to create a repeat ending when an explicit bar rest is selected.  

STEAM-6760  Rests  
Setting a property on an implicit rest no longer causes all other selected items to be 

removed from the selection.  

STEAM-7012  Rests  
The Bar rest design in long time signatures option on the Rests page of Notation 

Options now works correctly when adding bars to the end of the flow.  

STEAM-7545  Rests  
The presence of local time signatures on one staff no longer prevents multi-bar rests 

from appearing in the other staff if they line up with the bars of the global time signature.  

STEAM-5501  Setup mode  
Expanding a group in the Players panel will no longer cause the cards for the players 

within the group to be truncated incorrectly when the group is partially scrolled out of 

view.  

STEAM-5817  Tempo  
Tempo items with dx/dy offsets are no longer sometimes positioned inconsistently in 

relation to other items.  

STEAM-7473  Tempo  
The spacing of rhythm dots in metronome marks has been improved, particularly for 

durations shorter than a quarter note (crotchet).  

STEAM-7706  Tempo  
When the font style for gradual tempo items is set to absolute rather than staff-relative 

size, the dashed or dotted continuation line is now correctly drawn at absolute size too.  

STEAM-7723  Tempo  
Gradual tempo items with no drawn continuation line now draw a handle and attachment 

line at the right-hand end in Write mode.  
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ID #  Component  Issue  

STEAM-6777 Text  
System-attached text can now be edited correctly if the top staff of the system is hidden 

because it is empty.  

STEAM-7536  Text  Right-aligned text is no longer sometimes slightly truncated within a text frame.  

STEAM-7578  Ties  
When considering ties for the purposes of collision avoidance, the inside of the tie was 

incorrectly being considered instead of the outside. This problem has now been 

resolved.  

STEAM-7075  
Time 

signatures  
Under rare circumstances, notes and rests could be grouped incorrectly in irregular time 

signatures within an aggregate time signature; this problem has been resolved.  

STEAM-7587  
Time 

signatures  
Undoing the addition of a local time signature to an individual instrument now always 

correctly reinstates the previous global time signature.  

STEAM-7561  Tuplets  
Undoing the creation of a tuplet where a non-note item’s position overlaps with the new 

tuplet will no longer go wrong.  

STEAM-3656  User interface  
Drop-down menus in dialogs and panels no longer sometimes appear on the wrong 

display when running Dorico with multiple displays (Windows only).  

STEAM-7510  User interface  
Focus no longer gets lost after clicking the buttons in the note input toolbox, resulting in 

key commands not working until you click in the score (Windows only).  

STEAM-7637  User interface  
It is now possible to assign key commands to both File ▸Import ▸Flows and File 

▸Export ▸Flows.  

STEAM-7647  User interface  
The various annotations that appear at the top and bottom of the caret are now correctly 

scaled relative to the current staff size.  

STEAM-7663  User interface  
Maximizing the document window while a modeless dialog was open could in rare 

circumstances lead to Dorico hanging; this has now been resolved (Mac only).  
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Known issues and solutions  
 

Frequently asked questions  

Answers to frequently asked questions about Dorico can be found online in the 

Dorico forum.  

Knowledge base  

For the latest information about issues and solutions you may encounter when 

running Dorico, please consult the Knowledge Base.  

Entering the eLicenser Activation Code (Mac only)  

When you first run Dorico and are prompted to enter your Activation Code, you 

may find that after you have successfully activated your Soft-eLicenser, you must 

quit and restart Dorico for the application to detect that it is fully licensed.  

Key commands to transpose notes by an octave (Windows only)  

The Intel Graphics Adaptor drivers used by many Windows computers define a 

default key command to flip the screen by 90, 180 and 270 degrees via a shortcut 

Ctrl+Alt+up/down/left/right arrows.  

Ctrl+Alt+up/down option conflicts with the key commands in Dorico note input for 

transposing notes by an octave.  

For information about how to disable the default Intel Graphics Adaptor key 

command, consult the Knowledge Base.  
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